using your Treo™ 600 smartphone by palmOne

Includes setup information and instructions for most tasks
Copyright
Copyright © 2004 palmOne, Inc. All rights reserved. palmOne, Treo, the palmOne and Treo logos, Blazer, Palm, Palm OS, HotSync, Graffiti, and Palm Powered are among the trademarks or registered trademarks owned by or licensed to palmOne, Inc. or its subsidiaries. This product contains ACCESS Co., Ltd’s NetFront 3.0 Internet browser software. © 1996-2004 ACCESS Co., Ltd. and ACCESS Systems America, Inc. NetFront is the trademark or registered trademark of ACCESS Co., Ltd. in Japan and in other countries except the United States of America. NetFront is a registered trademark of NetFront Communications, Inc. in the United States of America and is used under a license. All other brand and product names are or may be trademarks of, and are used to identify products or services of, their respective owners.

Disclaimer and limitation of liability
palmOne, Inc. and its suppliers assume no responsibility for any damage or loss resulting from the use of this guide. palmOne, Inc. and its suppliers assume no responsibility for any loss or claims by third parties that may arise through the use of this software. palmOne, Inc. and its suppliers assume no responsibility for any damage or loss caused by deletion of data as a result of malfunction, dead battery, or repairs. Be sure to make backup copies of all important data on other media to protect against data loss.

Software download available
Palm® Desktop software is supplied on a CD-ROM disc. If you do not have access to a CD-ROM drive for your computer, you can download this software from www.palmOne.com.
Contents

1 Contents
2 Welcome
3 If you read nothing else...
4 read this now:
5 getting started
6 What you’ll need
7 Treo overview
8 Charging the battery
9 Turning Treo on and off
10 Making your first call
11 first day:
12 learning the basics
13 Moving around the Treo™ screen
14 Using the keyboard
15 Launching applications
16 Setting up your computer
17 Synchronizing contacts and other personal data
18 Battery life
19 Where to learn more
20 first week:
21 using phone, web, and messaging
22 Phone overview
23 Dialing calls
24 Receiving calls
25 Using voicemail
26 Managing active calls
27 More ways to manage calls
28 Managing contacts
29 Defining Favorites buttons
30 Using a phone headset
31 Browsing the web
32 Working with pictures
33 SMS
34 MMS
35 first two weeks:
36 using organizer features
37 Calendar
38 To Do List
39 Memo Pad
40 CityTime
41
Welcome

Congratulations on the purchase of your Treo™ 600 smartphone by palmOne™. You now have
• an advanced mobile phone*
• a Palm Powered™ organizer with portable expansion capability (SD™ media)
• a digital camera**
• email*
• web browsing*
• SMS*
• M MS*
all in one compact and indispensable device.

* Requires service contract with Verizon

** There are two models of Treo 600 available through Verizon: one comes with a camera and
the other does not come with a camera. The packaging for your Treo 600 identifies whether a
camera is included.

This guide will help you set up your Treo and quickly learn to use it.
If you read nothing else...

This guide is designed to get you using your Treo quickly, starting with just the basics. As you become more comfortable with your Treo and want to learn more, come back and read the other sections.

Read this Now: Getting Started
Follow these instructions to set up your Treo and make your first call.

First Day: Learning the Basics
Read these pages to learn how to enter text, move around the screen, and set up synchronization.

First Week:
Using Phone, Web, and Messaging
Learn how to use all the great wireless features of your Treo, including phone, web browsing, and messaging.

First Two Weeks:
Using Organizer Features
Your Treo is not just a phone. It also includes a full-featured Palm Powered organizer that gives you instant access to your Calendar, To Do List, Memo Pad, CityTime, Calculator, and more.

First Month: Managing Applications
Learn how to add or delete extra applications and use an expansion card with your Treo.

When You’re Ready:
Customizing your Treo
Once you’ve learned the basics, you’ll want to explore additional features on your Treo and customize its settings.

If Something Happens: Help
If something goes wrong or you can’t figure out how to use a Treo feature, we can help. See these pages for answers to frequently asked questions.
read this now: getting started
What you’ll need

As you work through the instructions in this guide, you’ll need all the items that came in the Treo™ 600 smartphone box (see page 7) as well as the following:

- an activated Verizon Wireless account with data services*
- a location with wireless coverage for your phone
- an electrical outlet
- the computer that you’ll use to synchronize your personal data
- the CD included in the box

* You cannot use email, web browsing, or MMS messaging without data services.
Treo overview

You should have received all of the following components in the Treo box:

**Hardware**
- Treo handset
- protective case
- AC charger
- USB HotSync® cable
- headset

**Documentation and software**
- Treo 600 Quick Reference Guide
- Treo 600 Manual In Motion CD
- Using Your Treo (this book)
- Synchronization software CD

You can purchase a separate serial HotSync® cable and other accessories. For more information, visit www.palmOne.com.

Warranty does not cover damage by Secure Digital (SD™) cards that do not meet SD Memory Card Specifications. SD cards that do not meet SD Memory Card Specifications may damage Treo 600.
Treо handset features

The following illustrations show the locations and names of the physical features of the Treо. Refer back to these illustrations while following the instructions in this guide.

A. Antenna
B. Wireless Mode button
C. Infrared (IR) port
D. Ringer switch
E. Stylus
F. Expansion card slot
Be careful not to scratch or crush your Treo's touchscreen. Use the pouch provided with your Treo. Do not store it in a place where other items might damage it.
There are two models of Treo 600 available through Verizon: one comes with a camera and the other does not come with a camera. The packaging for your Treo 600 identifies whether a camera is included.

IMPORTANT: Treo’s speaker includes a large magnet, so be sure not to store your Treo near credit cards or other items that could be demagnetized.

A. Camera lens*
B. Speaker
C. Reset button
D. Reset tool (within stylus)

* There are two models of Treo 600 available through Verizon; one comes with a camera and the other does not come with a camera. The packaging for your Treo 600 identifies whether a camera is included.
Charging the battery

Before using your Treo, you need to fully charge the battery. Your phone may not turn on at all when you first remove it from the box. We recommend that you charge your phone for three hours or until the LED is solid green.

1. Plug the AC charger into a wall outlet.
2. Connect the charger cable to the bottom of the Treo with the word UP facing in the same direction as your Treo screen.
3. To confirm that your Treo is charging, check the LED.
   - When the LED is solid red, your Treo is charging.
   - When the LED turns solid green, your Treo is fully charged.
   - If the LED does not light up when you connect your Treo to the charger, double-check the cable connection and the electrical outlet to which it is connected.

Battery consumption varies based on your personal usage. Consumption factors include signal strength, backlight and speakerphone usage, and whether calls are data or voice calls.
After you turn on your Treo, the onscreen battery gauge displays power status:

- Full battery icon  ●: Battery is charged
- Partial battery icon  ●: Battery has some power and is not charging
- Empty battery icon  ●: Battery needs charging immediately
- Red lightning bolt  ●: Battery is charging
- Green lightning bolt with full battery icon  ●: Battery is fully charged
Turning Treo on and off

You can use the Palm OS® features of your Treo independently of the wireless features and applications. Therefore, the screen and Wireless Mode are designed to be turned off and on separately.

Turning the screen on and off
1. Press the Screen button to turn on the screen.
2. Briefly press the Screen button to turn off the screen.

Turning Wireless Mode on and off
Wireless Mode allows your Treo to connect to the Verizon network so that you can make and receive phone calls and use other wireless services.
1. Press and hold the Wireless Mode button to turn on Wireless Mode. You will hear a series of ascending tones. When Wireless Mode is on, your Treo connects to a mobile network, and you can use the phone and Internet features (if supported by the local network).
2. Press and hold the Wireless Mode button again to turn off Wireless Mode. You will hear a series of descending tones. When Wireless Mode is off, your Treo is not connected to the Verizon network. You can still use the organizer and other Palm OS features. This is ideal for airplane flights and for maximizing battery life.
Making your first call

We recommend that you charge your Treo for a full three hours (or until the LED is solid green) before using it for the first time.

1. Press Phone 📞.
2. If a Setup screen appears, follow the instructions to select a language and calibrate the screen. If a Setup screen doesn’t appear, you’re ready to continue; press Center to unlock the keyguard feature.
3. Press and hold the Wireless Mode button 📞. You will hear a series of ascending tones.
4. Allow the Treo to complete a network search. The search may take several seconds. When it’s done, the network status icon 📱 appears in the upper right.
5. Tap the onscreen Dial Pad or use the number pad on the Treo keyboard to type *228.
6. Press Center to dial, and follow the voice prompts to program your phone.
7. When programming is complete, use the 5-way navigation control to choose Hang Up All.

If No Service appears in the upper left, you are out of a wireless coverage area. If you believe you are in a wireless coverage area and this problem persists, contact Verizon for assistance.

To adjust the contrast or how the screen responds to the stylus, run the Welcome application at any time. (see page 121).

Learn how to quickly redial your most recent calls on page 40.
Adjusting call volume

While a call is in progress, press the volume buttons on the side of your Treo to adjust call volume.

What's my number?

1. Make sure Wireless Mode is on (see page 13).
2. Press Phone .
3. Press Menu .
4. From the Options menu, choose Phone Info (/i).

If your phone number doesn't appear in Phone Info, follow the steps on page 14. Next turn Wireless Mode off and on again before you check Phone Info again.
Making your first call
first day: learning the basics
Moving around the Treo™ screen

To move around the Treo™ 600 smartphone screen, you can use the 5-way navigation control, or tap items on the screen with the stylus. Once you’ve used your Treo for a while, you’ll find your own favorite way to scroll, highlight, and select menu commands.

The 5-way navigation control includes Right, Left, Up, Down, and Center buttons.

Some third-party applications may not work with the 5-way navigation control, and you must use the stylus instead.

In this guide, we use arrow icons to indicate directions on your Treo’s 5-way navigation control. These are different from any onscreen arrows that you tap with your stylus or select with the 5-way navigation control to display pick lists.

5-way buttons:

On screen arrows:

Scrolling through screens

In the same way that you scroll on a computer, you scroll on the Treo to move from field to field, or page to page, or in some cases to highlight an item or option in a list.

You can scroll in any of several ways:

- Press the 5-way navigation control on the front of the Treo. Pressing Right ➤, Left ◄, Up ▲, and Down ▼ moves to the next field, button, or action in that direction.
• Tap an onscreen scroll arrow:

- Press Option ⪞ and Up ↑ or Down ↓ to scroll to the next page of information within the current record.
- When inside a text field, press Up ↑ and Down ↓ to scroll through the text.
- Drag the slider of an onscreen scroll bar.

Highlighting items

The 5-way navigation control lets you highlight items before launching or selecting them.

• When an onscreen button (OK, Cancel, etc.) or pick list is highlighted, a blue glow appears around the border.

• When a phone number, email address, or web link is highlighted on a web page or in a message, the text appears in reverse type (light text on a dark background).

• When an entire text entry field is highlighted, you can press Center to edit the text. After you edit the text, press Center again to highlight the entire field.
You can also use the stylus to highlight text on the screen. Highlighted text appears in reverse type.

- Drag the stylus across the text you want to highlight.
- Double-tap a word to highlight it.
- Triple-tap a line of text to highlight it.

Accessing command buttons

Command buttons, such as New, OK, and Details appear at the bottom of the screen. In many cases you can jump directly to these buttons instead of scrolling to them.

- From a list screen, such as the Contacts list press Right → to jump to the first button.
- From a screen where you create or edit entries, such as Edit Contacts or Day View in Calendar, press Center to jump to the first button.
- From a dialog, such as Edit Categories, press Right → to scroll to the first button, or press Option ⌘, then Return ⏎ for OK, or Option ⌘, then Backspace ⌘ for Cancel.

Choosing or activating items

After highlighting an item with the 5-way navigation control, you can choose or activate it by pressing Center. You can also choose an item by tapping it with the stylus.
Selecting menu items.

Many applications have menus to provide access to additional features. These menus are usually hidden from view, but they appear when you press Menu. To get the most out of your Treo, it's a good idea to familiarize yourself with the additional features available through the various application menus.

1. Press Menu to display an application's menus.
2. Press Right and Left to switch between menus.
3. Press Up and Down to highlight a menu item.
4. Press Center to choose the menu item, or press Menu to close the menu and cancel your selection.

Most menu commands have keyboard shortcuts listed in the menu. To use a shortcut, press Menu plus the shortcut letter. You don't have to see the menu item to use the shortcut.
Choosing options in a pick list

A range of options is often presented in a type of menu called a pick list, which can be identified by a downward-pointing arrow. Pick lists are different from the application menus described above.

To choose from a pick list, do one of the following:

- Use the 5-way navigation control to highlight the pick list, then press Center to display the items in the list. Press Up and Down to highlight the item you want, then press Center to accept your selection.
- Use your stylus to tap the pick list, then tap the item you want from the list.

To exit the pick list and cancel your selection, press Left, Right, or tap outside the pick list.
Using the keyboard

When using the keyboard, most people find it easiest to hold the Treo with two hands and use the tips of both thumbs to press the keys, as shown above.

Using the keyboard backlight

- To turn on the backlight, press Option ☺ then ◆. The backlight may not be visible in bright sunlight.
- The backlight turns off if the keyboard is not in use.
Entering lowercase and uppercase letters

- To type lowercase letters, press the desired keys.
- To type an uppercase letter, press Shift (здоровья), then type a letter. You don't need to hold down Shift while typing a letter.
- To turn Caps Lock on, press Shift (здоровья) twice. To turn it off, press Shift (здоровья) again. When Caps Lock is on, this symbol appears in the lower right:

Entering numbers, punctuation, and symbols that appear above the letters on the keys

- Press Option (здоровья), then press the key with the desired character shown above the letter. You don't need to hold down Option while pressing the second key.
- To turn Option Lock on, press Option (здоровья) twice. To turn it off, press Option (здоровья) again. When Option Lock is on, this symbol appears in the lower right:

Entering other symbols and accented characters

1. Type the character that corresponds to the symbol or accented character you want. See the table on the next page.
2. Press Alt (здоровья).
3. Press Up or Down to highlight the desired character.
4. Press Center to insert the character, or just continue typing the next character.
<table>
<thead>
<tr>
<th>Symbols and accented characters</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type.. then press Alt to choose..</strong></td>
</tr>
<tr>
<td>a</td>
</tr>
<tr>
<td>A</td>
</tr>
<tr>
<td>b or B</td>
</tr>
<tr>
<td>c</td>
</tr>
<tr>
<td>C</td>
</tr>
<tr>
<td>d</td>
</tr>
<tr>
<td>e</td>
</tr>
<tr>
<td>E</td>
</tr>
<tr>
<td>f or F</td>
</tr>
<tr>
<td>i</td>
</tr>
<tr>
<td>I</td>
</tr>
<tr>
<td>I or L</td>
</tr>
<tr>
<td>m or M</td>
</tr>
<tr>
<td>n</td>
</tr>
<tr>
<td>N</td>
</tr>
</tbody>
</table>

Using the keyboard :: 25
Launching applications

Each of the three application buttons on the front of the Treo can be used to launch two applications. To access a button's primary application, simply press the button. To access a button's secondary application, press Option ( ), then press the application button. The fourth button turns the screen on and off and controls the keyguard.

You can also customize the buttons yourself; see page 124 for details.
Launching applications

<table>
<thead>
<tr>
<th>Button</th>
<th>Primary application</th>
<th>Secondary application</th>
</tr>
</thead>
<tbody>
<tr>
<td>🇺🇸</td>
<td>Phone</td>
<td>🇺🇸 + 🇺🇸 Blazer® Web Browser</td>
</tr>
<tr>
<td>🇺🇸</td>
<td>Calendar</td>
<td>🇺🇸 + 🇺🇸 Memo Pad</td>
</tr>
<tr>
<td>🇺🇸</td>
<td>SMS</td>
<td>🇺🇸 + 🇺🇸 MMS</td>
</tr>
<tr>
<td>🇺🇸</td>
<td>Screen (on/off)</td>
<td>🇺🇸 + 🇺🇸 Keyguard</td>
</tr>
</tbody>
</table>

In Palm OS®, you access all available applications through a screen called the Applications Launcher:

1. Press Applications Launcher 🇺🇸.
2. Use the 5-way navigation control to highlight the application you want to use.
3. Press Center to launch the selected application.

Press Applications Launcher repeatedly to cycle through different categories of applications.

In the Applications Launcher, you can type the first few letters of the application's name to highlight it. For example, if you type ci it highlights CityTime. However, if you pause between typing letters, it highlights Calc, and then the first application that starts with i.
Setting up your computer

Synchronization lets you enter information on your computer (using Palm® Desktop or Microsoft Outlook for Windows) and then efficiently transfer that information to your Treo. At the same time, changes you make on your Treo are transferred to Palm Desktop or Microsoft Outlook. Even if you manage all your contacts on your Treo, synchronization is a great way to back up your data.

Before you can synchronize, you need to install Palm Desktop software on your computer. Even if you already own a Palm Powered™ device and have installed a previous version, you must install the software that comes with your Treo.

System requirements

Windows 98SE, Me, 2000, or XP*

- 32 MB of memory
- 30 MB of free hard disk space
- CD-ROM drive
- available USB port and USB HotSync® cable (cable included with your Treo)

Windows NT 4

- 32 MB of memory
- 30 MB of free hard disk space
- CD-ROM drive
- available serial port and serial HotSync cable (cable sold separately)

Macintosh OS 10.1-10.3.*

- 32 MB of memory
- 25 MB of free hard disk space
- CD-ROM drive
- USB port and USB HotSync cable (cable included with your Treo)
*Later versions may also be supported

IMPORTANT: If you’re upgrading from another Palm Powered device, follow the upgrade steps on page 138 before you set up your computer for your new Treo.

If you are synchronizing with a computer that is running Windows NT 4, you must use a serial HotSync cable, available for separate purchase at www.palmOne.com.
Connecting your Treo to your computer
1. Plug the AC charger into a wall outlet. If necessary connect an adapter.
2. Connect the charger to the short end of the HotSync cable. Be sure to match the sides of the connectors labeled UP.
3. Plug the USB HotSync cable into an available USB port on your computer.
4. Connect the long end of the HotSync cable to the bottom of your Treo with the button facing up.

A. USB cable
B. HotSync button

For best performance, plug your USB synchronization cable directly into a USB port on your computer. If you use a USB hub, make sure it is a powered hub.
Installing Palm Desktop software on your computer

Your computer needs all of its resources available to install the desktop synchronization software. Follow these guidelines for a successful installation:

1. Exit any applications that are currently running on your computer, including those running in the background.

2. Insert the CD that came with your Treo into the CD-ROM drive on your computer. If you are installing on a Macintosh, double-click the CD icon on the desktop, then double-click the Installer icon.

3. Follow the onscreen instructions of the installation program. Click Install Now to install Palm Desktop software. Please note these important points about the installation process:
   - If a language selection screen appears, choose the same language you use on your Treo.
   - During the installation process, you will be prompted to synchronize for the first time.

If you are installing on a computer at work, make sure your company allows you to install new software. Contact your company's IT department for help.
Synchronizing contacts and other personal data

Before you can synchronize your contacts and other personal data, you must install Palm Desktop software from the CD that came with your Treo. See page 30 for instructions.

1. Connect your Treo to your computer as described on page 29.
2. Press the HotSync button on the cable.
3. Wait for your Treo to display a message indicating that the process is complete.
   • If nothing happens, make sure that you installed Palm Desktop software and that the HotSync Manager application is running on your computer ( ).
   • If you want to synchronize data with applications other than Palm Desktop or Microsoft Outlook, you need to purchase additional third-party conduit software.
   • If you have any problems performing a HotSync operation, see page 147 for troubleshooting suggestions.

We strongly recommend that you install Palm Desktop software soon after you start using your Treo, and that you synchronize your Treo and computer frequently to keep your information up-to-date (and backed up) in both locations.
Battery life

Battery life depends on individual usage. When used as a phone, your Treo battery provides approximately 4 hours of talk time or 10 days of standby time on the 1900 MHz band. Talk time is slightly lower when operating on the cellular 800 MHz band. When used as an organizer only (no phone), the battery provides about 4 weeks of normal use.

Maximizing battery life

You can increase the life of your Treo battery by following a few easy guidelines. Remember that battery life depends on how you use your Treo.

- Charge your Treo whenever you're at your desk. The Li-Ion battery in your Treo has a much longer useful life when it is topped off frequently, versus charging it after it is fully drained.
- The wireless features (phone, email, messaging, and web) of your Treo generally consume more power than its organizer features. However, if you spend a lot of time using games, media players, eBooks, or other Palm OS applications, keep an eye on the battery level and charge when necessary.
- If you don't plan to use the wireless features on your Treo for a while, you may want to turn off Wireless Mode (see page 13) or let all calls be picked up by voicemail (see page 41), if your service plan includes voicemail features.

We recommend that you charge your Treo for a full three hours, or until the LED turns solid green, before using it for the first time.

If the battery is fully drained, and your Treo doesn't turn on, the Treo stores your data safely for about three days. We recommend that you charge and synchronize your Treo every day, especially if you use your phone often.

If the battery is fully drained, it may take a few moments for the LED to light up while charging.
As with any mobile phone, if you are in an area with no wireless coverage, your Treo continuously searches for a signal, which consumes power. If you cannot move to an area of better coverage, temporarily turn off Wireless Mode to conserve battery power.

- Use the keyboard backlight (see page 23) only when you need it.
- Turn down the screen brightness (see page 121).
- Decrease the Auto-off setting in General Preferences (see page 128). This turns off your screen automatically after a shorter period of inactivity.
Where to learn more

A quick introduction to your new Treo

- Tutorial: The Tutorial teaches you how to use many features of your Treo. It is already installed on your Treo, and you can launch it any time.

While using your Treo

- Tips: Many of the built-in applications include helpful tips for getting the most out of your Treo. To view these tips, launch an application, press Menu (Menu), then from the Options menu, choose Tips.
- Information: Many screens have an Information icon in the upper-right corner. Tap the Information icon with your stylus to learn about the tasks you can perform on that screen.
- Online support from palmOne: For up-to-date downloads, troubleshooting and support information, check out www.palmOne.com/support/treo600.

If you need more information

- Books: Many books on Palm Powered devices are available in local or online book retailers (look in the computers section).
- Online forums: Consult online Treo user discussion groups to swap information and learn about areas you may find nowhere else.
- Customer service from Verizon: For questions about your mobile account or features available on the network, contact Verizon for the latest information and help.
first week: using phone, web, and messaging
Phone overview

The Phone application lets you make and receive calls, store information about your contacts, and store Favorites for contacting people and launching applications. Be sure you know how to turn on Wireless Mode before reading this section (see page 13).

Accessing the Phone application

• Press Phone 📞.
You can use the icons at the top of the Phone screen to monitor the status of these items:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Network name</strong>&lt;br&gt;Displays Verizon Wireless when Wireless Mode is on and you are in a Verizon coverage area. If you are outside a Verizon coverage area, No Service or Roaming appears instead. No Service means that there is no coverage at all and Roaming means that another mobile service provider's network is available. When you turn off Wireless Mode, it displays Wireless Mode is Off.</td>
<td><strong>TTY/TDD Mode</strong>&lt;br&gt;Appears when TTY/TDD Mode is active.</td>
</tr>
<tr>
<td><strong>New voicemail</strong>&lt;br&gt;Appears when you have new voicemail messages. You can tap this icon to retrieve your messages.</td>
<td><strong>Roaming</strong>&lt;br&gt;Appears when you are outside a Verizon coverage area and roaming on another mobile service provider's network. This icon may blink if the provider is not on Verizon's preferred roaming list.</td>
</tr>
<tr>
<td><strong>Signal strength</strong>&lt;br&gt;Appears when Wireless Mode is on. The bars display the signal strength. The stronger the signal, the more bars appear. If you are outside a coverage area, both the tower and bars disappear.</td>
<td><strong>Data</strong>&lt;br&gt;Appears with green arrows when you are connected to a data network and transferring data. You cannot receive calls. Appears with gray arrows when you are standing by to send or receive data. You can still receive calls.</td>
</tr>
<tr>
<td><strong>Battery charge</strong>&lt;br&gt;Displays the battery charge status. When the battery drains to 25% of its capacity, the icon changes from blue to red. When the battery drains to 5% of its capacity, the icon changes from red to clear.</td>
<td><strong>Charging</strong>&lt;br&gt;Appears when your Treo™ 600 smartphone battery is charging.</td>
</tr>
<tr>
<td><strong>Charging</strong>&lt;br&gt;Appears when your Treo battery is fully charged.</td>
<td><strong>Charging</strong>&lt;br&gt;Appears when your Treo™ 600 smartphone battery is charging.</td>
</tr>
</tbody>
</table>
Dialing calls

Your Treo offers several options for making phone calls. As you become more familiar with your Treo, you’ll discover which method you prefer.

**Dialing with the keyboard**

1. Press Phone.
2. Using the numbered keys on the keyboard, type a phone number. You do not need to press Option to access the numbers on the keyboard.
3. Press Center to dial.

**Dialing by contact name**

Before you can dial a call by contact name, you must create contacts (see page 49) or import them with a HotSync® operation (see page 31).

1. Press Phone.
2. Use the 5-way navigation control to access the Contacts list.
3. Using the keyboard, begin typing one of the following for the contact you want to call:
   - First initial and last name
   - First name
   - Last name
4. Choose the number you want to dial.
5. Press Center to dial.

To start another search, press Backspace to delete letters you’ve entered. Or, just press Phone to start all over.
Dialing with a Favorites button
Before you can use Favorites buttons, you must create some Favorites entries. See page 51.
1. Press Phone.
2. Use the 5-way navigation control to access your Favorites buttons.
3. Highlight the desired button.
4. Press Center to dial the selected button.

Dialing with the onscreen Dial Pad
1. Press Phone.
2. Tap the onscreen Dial Pad to enter the number.
3. Press Center to dial.
Dialing from a web page or text message

Treo recognizes most phone numbers that appear in web pages or text messages.

1. Use the 5-way navigation control to highlight the phone number you want to dial.
2. Press Center to dial.

Redialing the last number you called

Do any of the following to redial the last number you called:

- Press Phone \(\text{\textsuperscript{9}}\), then press Center to see a list of your recently dialed numbers.
- Press Phone \(\text{\textsuperscript{9}}\), then press Center. Choose Dial Pad, then choose Dial to display the last number you dialed.
- Press Phone \(\text{\textsuperscript{9}}\), then press Center. Choose Call Log. This view shows all your recent calls in chronological order. Press Center to dial the last number you called.
Receiving calls

To receive calls, Wireless Mode must be on. This is different from having just the screen turned on (see page 13).

To answer a call, do one of the following:
• Using the 5-way navigation control, choose the onscreen Answer button.
• If the headset is attached, press the headset button.

To ignore a call and send it to voicemail, do one of the following:
• Press Backspace .
• Using the 5-way navigation control, choose the onscreen Ignore button.

To silence the ringer while your phone is ringing:
• Press the volume buttons or any key on your Treo except the 5-way navigation control, Space, Return, or Backspace.
• To immediately silence all system sounds including the ringer, slide the ringer switch to Sound Mode Off .

When you silence the ringer, you can either answer the call or let it ring through to voicemail.

If audio (MP3 music, for example) is playing, and a call arrives, you can still hear the phone ringing softly. To answer the call, do one of the following:
• Using the 5-way navigation control, choose the onscreen Answer button.
• Press the headset button (if headset is attached).

The audio continues playing but you won’t hear it during your call.

You must activate voicemail services on your account before sending a call to voicemail. Otherwise you can check the Call Log to see a missed call (if the caller’s number was not blocked).

To prevent calls from accidentally being answered while the phone is in a pocket or briefcase, you can disable the touchscreen when an incoming call arrives (see page 130).

See a photo of the person calling you! Learn how to assign a caller ID picture on page 118.
Using voicemail

Setting up voicemail
If you subscribe to voicemail services, you are prompted to enter a password the first time you call voicemail.
1. Turn on Wireless Mode, as described on page 13.
2. Press Phone .
3. Use the 5-way navigation control to access Favorites.
4. Choose the Voicemail Favorites button.
5. Follow the system prompts to create your password and record your greeting.

Your Treo connects to Verizon's automated voicemail system. If your Treo is unable to connect to the automated system, please contact Verizon for assistance.
Voicemail notification
When you have new voicemail, you are notified with an alert that indicates the number of messages you have waiting. A voicemail icon 📞 may also appear near the top of your screen.

<table>
<thead>
<tr>
<th>Voicemail</th>
</tr>
</thead>
<tbody>
<tr>
<td>📞 You have new voicemail</td>
</tr>
<tr>
<td>5:55 pm 3/15/04</td>
</tr>
<tr>
<td>OK Listen</td>
</tr>
</tbody>
</table>

Retrieving voicemail messages
If the Voicemail alert is on your screen, you can choose that button to hear your message(s). If you’ve already dismissed the alert, follow these steps to retrieve your messages:

1. Press Phone 📞.
2. From the Phone application Main view, Dial Pad, or Favorites, press and hold 1 on the keyboard. Treo dials Verizon’s voicemail system.
3. Enter your voicemail password using the Treo keyboard, or choose Extra Digits if you defined this option (see page 53 for information on editing Favorites buttons). Remember, you do not need to press Option to type numbers, *, or # while on an active call.
Managing active calls

When you make or receive a call, the Active Call view appears. Use the 5-way navigation control to access the onscreen buttons in this view:

- **Hang Up All** (or pressing Backspace): Ends the call immediately. You can also press the headset button (if the headset is attached).
- **Spkr-phone** (or pressing Space): Switches to the personal speakerphone.
- **Hold** (or pressing Period): Places the current call on hold.
- **Dial Pad** (or pressing Return): Opens the Dial Pad so you can manually dial additional numbers.
- **Mute**: Mutes the Treo microphone so you cannot be heard.
- **Add Call**: Lets you place another call while the first call is on hold. First choose Hold, then choose Add Call.
- **Extra Digits**: Dials any extra digits (such as a password or extension) that you assigned to a Favorites button. See page 52 for information on creating a speed dial Favorites button.

Press Phone repeatedly to toggle between the Active Call screen and the Main view of the Phone application.

The personal speakerphone lets you use other features, such as checking your calendar, during a call.

The Extra Digits button appears only during outbound calls that you dialed with a Favorites button to numbers that include pre-defined extra digits (see page 52).

To avoid accidentally pressing onscreen buttons while you’re holding the phone up to your ear to speak, you can disable the touchscreen during active calls (see page 130).

A. Caller’s name and number
B. Current duration of call
C. Hang up immediately
D. Switch to speakerphone
E. Place current call on hold
F. Mute the microphone
G. Open Dial Pad view
More ways to manage calls

Treo offers many advanced telephone features, including call waiting and conference calling.

Making a second call
You can make a second call while your first call is still active.
1. After dialing the first number, use the 5-way navigation control to choose Hold.
2. Use the navigation control to choose Add Call.
3. Dial the second number using Favorites, Contacts, Dial Pad, Call Log, or Redial list (see page 38).

The Active Call view now includes two status lines, each representing one of the calls. You can join the two calls in a three-way call, but you cannot switch between the two calls. To end both calls, choose Hang Up All.
Answering a second call (call waiting)
When you are on an active call, you can receive a second call. When the second call comes in, the Call Waiting dialog appears, giving you the following options for handling the second call:

- To place the current call on hold and answer the new call, use the 5-way navigation control to choose Answer.
- To send the new call to voicemail, use the 5-way navigation control to choose Ignore.

Making a three-way call
Talk to two people at the same time with three-way calling. Normal airtime rates apply for each of the two calls.
1. Dial the first number.
2. While the first call is active, place a second call.
3. Use the 5-way navigation control to choose Conf. This joins the two calls in a three-way call.
4. Use the navigation control to choose Hang Up All and end all the calls.

NOTE: You MUST hang up a three-way call before making any other calls.
Viewing minutes usage
1. Press Phone.
2. Press Menu.
3. From the Views menu, choose Call Log (/Y).
4. Choose Totals.
5. (Optional.) To reset the counters to zero, choose Reset Counters.
6. Choose Done.

Using voice dialing
You can place calls by saying a name if you subscribe to Verizon's Voice Gear service. Additional charges may apply.
1. Press *84 then Center.
2. Follow the system prompts.

Choosing your privacy settings
To maintain privacy, you can encrypt conversations when you place or receive calls, provided that this feature is supported by the network.

You can also choose whether your longitude and latitude position are available to the network and third-party applications at all times or only during an emergency call.

1. Press Phone.
2. Press Menu.
3. From the Options menu, choose Phone Preferences (/A).
4. Check the Enable Voice Privacy box.
5. Choose Location ON or 911 Only.
6. Choose OK.
When Voice Privacy is on, a **VP** icon appears to the right of the current time. If Voice Privacy is supported by the network, a **VP** icon also appears on the Active Call screen. When Location On is on, the Location **GPS** icon appears with transmission lines. When 911 Only is on, the transmission lines disappear.
Managing contacts

Contacts is a view in the Phone application. If you are familiar with Palm Powered™ devices, you may recognize that Contacts is similar to the Address Book application on previous devices.

Adding a contact
1. Press Phone .
2. Use the 5-way navigation control to access the Contacts list.
3. Choose New Contact.
4. Use the 5-way navigation control to move between fields as you enter information.
5. To place the entry in a category or mark it private, choose Details.
6. To add a note to an entry, choose Note.
7. After you enter all the information, choose Done.
Viewing or changing contact information
1. In the Contacts list, begin typing one of the following for the contact you want to view or edit:
   • First initial and last name
   • First name
   • Last name
2. Choose the name of the entry you want to open.
3. Choose Edit.
4. Make changes to the entry as necessary.
5. Choose Done.

Deleting a contact
1. Open the contact you want to delete.
2. Press Menu .
3. From the Record menu, choose Delete Contact (/ D).
4. Choose OK.

Defining your business card
1. Create a new contact with your business card information.
2. While still in Contact Edit view, press Menu .
3. From the Record menu, choose Select Business Card.
4. Now you can beam your business card to other Palm OS® devices. From the Main or Contacts view in the Phone application, press Menu . From the Record menu, choose Beam Business Card (/ M).
Defining Favorites buttons

Treo provides 50 programmable Favorites buttons for quick access to the following common tasks:

- Dialing a phone number (speed dial)
- Launching an application
- Accessing a web page
- Addressing a text message
- Accessing voicemail (preset on Treo)

You can assign a Quick Key to a Favorites button. Then from the Main, Favorites, or Dial Pad view, you can press and hold the Quick Key to launch the Favorite associated with it. Quick Keys are optional, must be letters, and are not case sensitive.
Creating a speed dial Favorites button

1. Press Phone .
2. Use the 5-way navigation control to access your Favorites buttons.
3. Choose a blank button.
4. Choose the Type pick list, then select Speed Dial.
5. Enter a label and phone number for the Favorite by doing one of the following:
   • If the entry is for an existing contact, choose Lookup. Start typing the last name of the contact, then select the contact when it appears in the Lookup list.
   • If the entry is for a new contact, type the Label, press Down  and type the Number.
6. (Optional) Enter a Quick Key. When you are in the Phone application, you can press and hold the Quick Key to instantly launch the Favorite.
7. (Optional) Choose More, and select advanced options:
   • Extra Digits: Lets you define additional digits to dial, such as a password or extension.
   • Dial Extra Digits Automatically: Dials predefined Extra Digits two seconds after dialing the phone number, when checked. Add commas to insert more pauses.
   • Ringtone: Assigns a special ringtone for incoming calls from that contact.
   • Image: Assigns a Caller ID picture that displays when that person calls.
8. Choose OK.
Creating an application, message, or web link Favorites button

1. Press Phone.
2. Use the 5-way navigation control to access your Favorites buttons.
3. Choose a blank button.
4. Choose the Type pick list, then select Application, Message, or Web Link.
5. Enter a label for the Favorite, and enter any other necessary information on the screen.
6. (Optional) Enter a Quick Key that launches the Favorite when pressed and held.
7. Choose OK.

Editing or deleting an existing Favorites button

1. Press Phone.
2. Use the 5-way navigation control to access your Favorites buttons.
3. Highlight the Favorites button you want to edit or delete.
4. Press Menu.
5. From the Edit menu, choose Edit Favorites Button (/E).
6. Make the desired changes. For example, you can add a Quick Key shortcut to any Favorite. When you press and hold the assigned letter from within the Phone application, the Favorite launches.
7. To delete the entry, choose Delete.
8. Choose OK.

You can also organize your Favorite buttons on different pages. From the Edit menu, choose Edit Favorites Pages.
Using a phone headset

You can connect a phone headset for hands-free operation. If you need to use your phone while driving, and this is permitted in your area, we recommend using a phone headset.

You can press the headset button to perform any of the following tasks:
- answer an incoming call
- answer a call-waiting call
- join two calls in a three-way conference
- hang up all calls

Headset specifications

Your Treo uses a 2.5mm, 3-pin headset connector. Use only headsets with this type of connector. When in doubt, ask the third-party headset manufacturer if their product is compatible with Treo phones. If the headset buzzes or the microphone doesn’t work properly, your headset may be incompatible with Treo.

In addition to the headset that came with your Treo, you can use other third-party headsets.

To hear stereo through the jack (such as music), you should use a stereo adapter or other accessory. Visit www.palmOne.com for more information.

The headset designed for previous models of Treo is not compatible with the Treo 600.

A. Speaker
B. Microphone
C. Headset button

Visit www.palmOne.com for more information.
Browsing the web

Blazer® Web Browser provides quick and easy access to web pages right on your Treo. You can view the regular sites you use today, including those with security and advanced features like JavaScript and frames. To browse the web, you must activate data services from Verizon.

Viewing a web page
1. Make sure Wireless Mode is turned on, as described on page 13, and that the Data Services icon appears in the Main view of the Phone application (near the top of the screen).
2. Press Phone .
3. Use the 5-way navigation control to choose Web.
4. Choose the Page View icon.
5. Press Space to jump between the Web page contents and the icons at the bottom of the screen.
6. Navigate to the web page you want:
   - To view a portal of mobile content designed specifically for your Treo, choose .
   - To go to any web page on the Internet, choose .
   - To view the previous or next page, choose or .
   - To refresh the page with the latest content available from the Internet, choose .

If you browse to a secure web page, a Lock icon appears.

Lots of pretty graphics slowing you down? Browse the web faster by turning off images. From the Options menu, choose Preferences, and then check the Don’t Show Images box.
Navigating in Optimized Mode

Blazer uses a patent-pending technology to optimize web pages for your Treo. By default, the browser reformat web pages into one column on your screen. This way, you can see most content without scrolling left or right.

- Press Up or Down to move through a web page.
- Press Left or Right to move between links on the page. To follow a link to another web page, highlight the link, then press Center. You can also tap the link on the screen with your stylus.

Navigating in Wide Page Mode

Some web pages, such as maps, are easier to view without the optimization done in Optimized Mode. You may want to view these pages in Wide Page Mode. This mode presents the web page as you would expect to see it on your computer's screen.

1. Go to the page you want to view.
2. Press Menu.
3. From the Page menu, choose Wide Page Mode (/W).
   - Press Up, Down, Left, or Right to scroll through the wide page.
   - To follow a link to another web page, tap the link with your stylus.

Creating a bookmark

Bookmarks let you instantly access a web page, without typing the address every time. Blazer can store up to 100 bookmarks or saved pages, allowing you to open your favorite web pages quickly. Remember, a Blazer bookmark is different from a Favorite (see page 51).

1. Go to the page you want to bookmark.
2. Press Menu.

Want to get to the icons faster? Press Space to jump down to the icons, or press Menu to access the commands through the menus.

Always using bookmarks? Make Bookmark View the default view when you launch the browser. From the Options menu, choose Preferences, then select the Bookmarks icon as your Initial View.
3. From the Page menu, choose Add Bookmark (/A).

![New Bookmark dialog box]

4. If desired, change the Name and Description.
5. Choose OK.

Saving a page
Blazer lets you save a page for offline viewing, so you don't need an Internet connection to view it later.

1. Go to the page you want to save.
2. Press Menu (Menu).
3. From the Page menu, choose Save Page (/S).
4. Choose OK.

To move a bookmark or saved page to a different slot on the current page, use the stylus to drag and drop it into another slot. To move a bookmark or saved page to a different page, drag and drop it on the corresponding page icon.
Viewing bookmarks or saved pages

Bookmarks and saved pages both appear in Bookmark view. Saved pages are indicated by a small triangle in the upper-right corner of the bookmark.

1. Choose the Bookmarks view icon.
2. Choose the bookmark or saved page you want to view.

Editing or deleting a bookmark or saved page

1. From the Bookmarks view, press Menu.
2. From the Bookmarks menu, choose Edit Bookmarks.
3. Choose the bookmark you want to edit or delete.
4. Enter the desired changes.
5. Choose OK.
Arranging bookmarks and saved pages
Blazer includes 10 pages for arranging bookmarks and saved pages by topic. For example, you can store travel links on one page, stock links on another, and business links on a third page.

1. From the Bookmarks view, press Menu (Menu).
2. From the Bookmarks menu, choose Edit Bookmarks.
3. Type a new title for this page.
4. Use the stylus to drag and drop bookmarks into different slots on the current page. To move a bookmark to a different page, drag and drop it on the corresponding page icon.
5. Choose OK.

Downloading files from a web page
Blazer lets you download files that are usable on your Treo, such as new applications or MIDI ringtones. When you download a file, it is automatically sent to the application that can use the file. Note: Only certain images tagged specifically for download can be downloaded by Blazer.

1. Go to the page that contains the link to the file you want to download.
2. Press Left • or Right • to highlight the link to the file, then press Center to initiate the download process.
Navigating web sites with split pages (Frames)

Some web sites split their pages into separate areas, each with their own scroll bars. You can navigate these sites more easily by "zooming in" on one of the separate areas. To do this:

1. Tap inside the area of the split page you want to make larger. Make sure you tap on an area that is not a link, otherwise, you will navigate to that link.

2. Tap the magnifying glass icon in the navigation bar. This will make the area you tapped on the entire page. Note: This icon only appears if you are on a page that is split into separate areas.

Copying text from a web page

You can copy text from a web page and paste it in other applications.

1. Use the stylus to highlight the text you want to copy.
2. Press Menu.
3. From the Edit menu, choose Copy (/C).
4. Go to the application in which you want to paste, then position the cursor where you want to paste the text.
5. Press Menu.
6. From the Edit menu, choose Paste (/P).

Using the History list

The History list stores the addresses of the last 100 pages you visited. Items in the History list are sorted chronologically.

1. From the Page view, press Menu.
2. From the Page menu, choose History.
3. Press Up to access the list, then press Down to navigate through the list.
4. Choose the web page you want to load.
Finding text on a web page

1. From the Page view, press Menu.
2. From the Page menu, choose Find Text on Page.
3. Type the text you want to find.
4. Check or uncheck the Wrap Search box to indicate whether you want the search to wrap from the end of the page to the beginning when the end is reached.
5. Choose Find to start the search.

Customizing your Blazer Web Browser settings

1. Press Menu.
2. From the Options menu, choose Preferences.
3. Set any of the following preferences:
   - Home Page: Sets the web page that appears when you choose the Home icon.
   - Restore Default: Resets the home page to the factory setting.
   - Initial View: Determines which view displays when you launch Blazer.
   - Don’t show images: Selects whether you want images to appear when you load a web page. If you don’t view images, web pages will load faster.
4. Choose Advanced and set any of the following preferences:
   - Set limit on memory for storing recently viewed pages (cache): Sets the amount of memory used for your cache. Pages are cached so they load faster the next time you view them.
   - Memory Management: Enables you to free up memory on your phone by clearing the memory for recent pages, history, and cookies.
   - Set Proxy: Sets up a proxy server to access the Internet. If your connection requires a proxy server, please contact your Internet service provider or IT administrator for this information.
   - Accept cookies: Allows some web sites to store personalized information on your Treo. Some sites do not work properly unless you select this option.

5. Choose OK.
Working with pictures

There are two models of Treo 600 available through Verizon: one comes with a camera and the other does not come with a camera. The packaging for your Treo 600 identifies whether a camera is included. If your Treo 600 does not include a camera, then the section in this chapter about taking pictures does not apply to you. Even if your phone does not include a camera, you can still receive and view pictures, send pictures to other people as attachments or picture messages, and use pictures to personalize your device (such as wallpaper or picture caller ID; see page 118 for details).

You can move pictures to a Windows computer by performing a HotSync operation. Pictures are 12-bit color at a maximum of 640x480 resolution (0.3 megapixels).

Taking a picture
1. Press Phone.
2. Press Right to launch Pictures.
3. Point the lens on the back of your Treo at the subject you want to photograph.
4. Press Center to capture the picture.
5. If desired, edit the picture name and category at the top of the screen.
6. Choose Save to keep the picture, choose Don’t Save to discard it, or choose Send to send the picture and save it at the same time.

When using the camera in low light, you may see blue dots on the screen, especially in the darker areas. Once you capture the picture, image quality improves.
Working with pictures

Viewing a picture
1. Choose the Pictures view icon.
2. Choose the picture you want to view.
3. Choose Done.

Sending a picture
You can send a picture to other picture-enabled mobile phones, to an email address, or to the Pix Place website. To store and manage your pictures on the Pix Place website, you need to set up a Pix Place account (additional charges may apply). To learn more about Pix Place, visit the Verizon Wireless website.
1. Make sure Wireless Mode is turned on, as described on page 13, and that the Data Services 1tx icon appears in the Main view of the Phone application (near the top of the screen).
2. From the Pictures view, choose the picture you want to send.
3. Choose Send.
4. If the Send With dialog appears, choose the application you want to use to send the picture.
5. After the application launches, address and send the message.
Moving pictures
1. From the Pictures view, choose the picture you want to move.
2. Press Menu.
3. From the Picture menu, choose Move (/ M).
4. Choose the category or expansion card where you want to move the picture.
5. Choose Move to finish.

Deleting a picture
1. From the Pictures view, choose the picture you want to delete.
2. Choose Delete.
3. If prompted, choose OK to confirm deletion.

You can rename a picture.
From the Picture menu, choose Edit Name.

Move or copy a picture to your SD card. Select a picture, then press Menu.
From the Picture menu, choose Move, then choose your SD card from the pick list. See page 111 for more information on using expansion cards.
Customizing your Pictures settings

1. From any view in the Pictures application, press Menu.
2. From the Options menu, choose Preferences.
3. Set any of the following preferences:
   - Default name*: Names a series of pictures to be captured, such as Seattle001, Seattle002, etc.
   - Category*: The default category for newly captured pictures.
   - Picture size*: The default size for newly captured pictures. Large is 640 x 480 pixels, small is 120 x 160 pixels.
   - Play capture sound*: Plays a sound to confirm picture capture.
   - Confirm before deleting: If checked, Pictures asks if you're sure you want to delete a picture before erasing it.
   - Confirm before saving*: If checked, Pictures asks if you're sure you want to save a picture before storing it on your Treo.
   - Backup settings: When activated, backs up the Treo image database on your desktop computer.
4. Choose OK.

* These options apply only if your Treo includes a camera.
Viewing pictures on your computer (Windows only)

When you perform a HotSync operation, your Treo images are copied to your desktop computer. You can view these pictures in JPEG format, or email them to friends using your desktop email application.

1. Locate your Pictures folder. This is most likely at C:\Program Files\palmOne\Treo Pictures\(user name) or if you upgraded from another Palm Powered device, at C:\Program Files\Palm\Treo Pictures\(user name) or C:\Program Files\Handspring\Treo Pictures\(user name).

2. Double-click any file to view it with the default picture viewing software on your Windows computer.
Text messages are brief notes that you exchange with other mobile phones that have text messaging capability (also known as short messaging or SMS). Messages must be 160 characters or less. Refer to your service plan for per-message pricing.

Creating and sending a message
1. Make sure Wireless Mode is turned on, as described on page 13.
2. Press SMS.
3. Choose New.
4. If the recipient is in your Contacts list, start typing the first initial and last name (no spaces). Otherwise, type the full phone number, email address, or alias. Destination email addresses are included in the 160 character count.
5. Press Down. If you typed just a few letters of the recipient’s name, choose the recipient’s phone number or email address from the list that appears.
6. Type your message.
7. Choose Send.

When entering a message, you can insert emotive symbols by choosing Emotions or predefined QuickText phrases. To add a new phrase, select Edit QuickText from the list.

Not all symbols available on your device may be used in text messages. The SMS application automatically replaces invalid characters before it sends your message.

You can address text messages to multiple recipients by separating the addresses with a comma. If you address a single message to three people, you will be billed for three messages.
Receiving messages

When your phone is on and in an area of wireless coverage, you will automatically receive text messages sent to you. You can configure your Treo to automatically notify you when new text messages arrive, using a ringtone and vibration or simply an onscreen alert.

From the New Message alert:
- To view your message(s), choose Go To.
- To dismiss the alert, choose OK. The message goes straight to the Inbox.
- To be reminded of the new message again in 5 minutes, choose Snooze.
Using links in messages
When you receive a text message that contains a telephone number, email address, or URL, you can dial the number, send an email message, or go to the web page immediately.

1. Choose a message from the list.
2. Choose the phone number, email address, or URL (appears as underlined blue text).
3. Your Treo automatically launches the appropriate application from the link.

Managing your messages
The status icons that appear next to each message in the Inbox, Outbox, and Sent folders indicate the following:

- 📨 An incoming message. Unread messages appear in bold; messages you've read appear in plain text. Urgent messages appear with a red exclamation point !
- 📧 An item that is locked and cannot be deleted or purged until you unlock it.
- 📮 An outbound message that is waiting to be sent or a message that was sent and has not yet been received. The arrow stays gray until the recipient receives the message, and then it turns yellow.
- 📯 A chat session. Chats containing unread incoming messages appear in bold text.
- 📧 A voicemail message. An unread voicemail message appears in bold.
In list view you can rearrange the messages in any folder using the Sort command.
1. From list view, press Menu.
2. From the View menu, choose Sort by Name or Sort by Date.

In list view you can delete several messages at once from any folder using the Purge command.
1. From list view, press Menu.
2. From the Message menu, choose Purge (/K).
3. Choose the Purge pick list, then select an option.
4. Choose OK.

Chatting with SMS

When you exchange more than one text message with a single contact, your messages are grouped into a chat session. The upper part of the Chat view displays all messages you’ve exchanged with this contact, and the lower part provides a text entry area. You can carry on multiple chats at the same time and easily switch between them, using the pick list at the top of the screen.
1. From the Inbox, choose a chat.
2. Type your message.
3. Choose Send.

Customizing your SMS settings
1. Press Menu.
2. From the Options menu, choose Preferences.
3. Set any of the following preferences:
   - Messages: Your preferences for individual text messages.
     - Confirm message deletions: Indicate whether you want deletion confirmation messages to appear.
     - Return to list view after deletion: Indicate whether you want to return to the list view or the next item in the folder after deleting a message.
     - Addressing new messages: Indicate whether you want the keyboard to default to letters or numbers when you type an address.
   - Chat: Your preferences for chat sessions.
     - Timestamp pick list: Indicate which timestamp information you want to see in the Chat screen. You can see both the time and date, either time or date (depending on when the message was sent), or no timestamps.
- Display my name in chat window as: Enter the name you want displayed as the label for your messages in the Chat screen.
- Label Color: Select the color in which you want messages to appear.
- Use color for: Indicate whether you want to view both the message label and message in a different color, or only the name.

4. Choose OK.
Multimedia messages contain one or more pages of pictures and sounds as well as text. Even if your phone does not include a camera, you can still receive and view pictures. You can include any of the following items in your message:

- **Ringtones**
  - MIDI: Up to 16-voice polyphony (Standard or SP-MIDI format), 64 KB per sound file
  - iMelody: Up to 64 KB per sound file
- **Sound clips**
  - QCELP: Up to 60 seconds playback time, 64 KB per sound file
- **Pictures**
  - JPEG: Up to 640 x 480 pixels, 64 KB per image file
  - GIF: Up to 640 x 480 pixels, 64 KB per image file

Creating and sending a multimedia message
1. Make sure Wireless Mode is turned on, as described on page 13.
2. Press Phone and make sure that the Data Services icon appears in the Main view of the Phone application (near the top of the screen).
3. Press Applications Launcher.
4. Choose the pick list in the upper-right corner, then select All.
5. Choose the MMS icon.

Before you use your Treo to send or receive multimedia messages, consult Verizon for pricing and availability of multimedia messaging services.

Save a message as a template for other messages. From the Compose menu, choose Save as Template. To create a message based on the template, go to the Template folder and then choose the template you want to use.
6. From the MMS list view, choose New.

7. If the recipient is in your Contacts list, choose the To pick list, then select Address Book Lookup. Otherwise, type the number of a phone that supports multimedia messaging, or an email address or alias.

8. Add ringtones, sound clips, pictures, or text to the message:
   - Choose the Picture icon to insert a photo or drawing. Once a picture is inserted, choose the picture to edit or remove it.
   - Choose Sound to record a new voice message.
   - Press Menu. From the Compose menu, choose Attach Sound to add a ringtone or an existing voice message.
   - Add more pages to your message using the Next Page arrow in the title bar.
   - Select the text entry area and type any text you want to include with the message.

9. Choose Preview to view the message as the recipient will see it.

10. Choose Send to finish.
Receiving multimedia messages

You can automatically download new messages or have Treo notify you that a message is ready to download. In either case, an alert appears when you have a new message.

- From the alert:
  - To view your message(s), choose Go To.
  - To dismiss the alert, choose OK. The message goes straight to the Inbox.
  - To be reminded again in 5 minutes, choose Snooze.
Viewing/playing a multimedia message
1. From the Inbox, choose the message you want to view.
2. If there are sounds or multiple pages, playback will begin immediately.
3. Use the onscreen controls to scroll to other pages and messages.
   • To play or save a sound, choose the Sound icon 🎧. You can access saved sounds later by pressing Applications Launcher 📱, then choosing Sounds.
   • To save a picture, tap it with your stylus or finger. You can access saved pictures later by pressing Phone 📱, then pressing Right ➔ to launch Pictures.
   • To select the text, position the cursor in the text area then press Center.
   • To stop playback of a message, choose Play/Stop.
4. Choose OK.

Responding to a multimedia message
1. From the MMS list view, choose the message you want to respond to.
2. Choose Respond.
3. Choose Reply with SMS, Reply, Reply All, or Forward.
Managing multimedia messages
You can rearrange messages in any folder using the Sort command.
1. From list view, press Menu (Menu).
2. From the View menu, choose Sort by Name or Sort by Date.

In list view you can delete several messages at once from any folder using the Purge command.
1. From the MMS list view, press Menu (Menu).
2. From the Message menu, choose Purge.
3. Choose the Purge pick list, then select a purge option.
4. Choose OK.

Customizing your MMS settings
1. Press Menu (Menu).
2. From the Options menu, choose Preferences.
3. Set any of the following preferences:
   • Automatically collect messages: Indicate whether you want to automatically download incoming multimedia messages.
   • Confirm message deletion: Indicate whether you want deletion confirmation alerts to appear.
   • To: is numeric: Indicate whether you want to type numbers or letters in the To field by default.
   • Display alerts in Privacy Mode: Indicate whether you want the subject and sender’s name to appear in the notification alert.
4. Choose OK.
first two weeks: using organizer features
Calendar

Displaying your calendar

- Press Calendar repeatedly to cycle through the various active views.

- Use the 5-way navigation control to move to another day, week, or month (depending on the current view).

- Choose Go or press Menu. From the Options menu, choose Go to Day (D), then choose a date from the calendar.

Creating an event

1. Press Calendar until you are in Day view.
2. Press Left and Right to select the desired day.
3. Using the keyboard, type a starting time for the event. For example, type 53 for 5:30 (Remember to press Option before typing numbers).
4. Press Down and type the ending time for the event.
5. Choose OK.
6. Type a description for the event.

Adding an alarm reminder to an event
1. In Calendar, highlight the event.
2. Choose Details.
3. Check the Alarm box and choose the number of minutes, hours, or days before the event you would like to receive the alarm.
4. Choose OK.

The silent alarm for untimed events is defined by minutes, days, or hours before midnight of the date of the event.

When an alert occurs, the Reminder screen displays all your Treo’s pending alerts. Tap an item’s description to jump to that item, or check the box to clear that item.
Creating an untimed event
An untimed event, such as a birthday or anniversary, does not occur at a particular time.
1. Press Calendar until you are in Day view.
2. Press Left and Right to go to the date of the event.
3. Make sure nothing is highlighted.
4. Type a description for the event.

Editing or deleting an event
1. Highlight the event you want to reschedule.
2. Choose Details.
3. Change the date and time as needed, or choose Delete.
4. Choose OK.

Scheduling a repeating event
1. Create an event, then highlight it.
2. Choose Details.
3. Choose the Repeat box, then choose a repeat interval.
4. For weekly events, choose the day(s) the event repeats; for monthly events, choose the Day or Date option.

To enter a birthday or anniversary, create an untimed event. Then, from the Details screen, choose Year as the repeat interval.
5. If the event has an ending date, choose the End on pick list, then select Choose Date, and select the ending date.
6. Choose OK.

Customizing general preferences for your calendar

1. Press Menu.
2. From the Options menu, choose Preferences (/ R).
3. Set any of the following preferences:
   • Start Time and End Time: The beginning and end of the day shown on Calendar screens.
   • Event Duration: The default duration of a new event.
   • Week Start: The day on which the calendar week starts.
   • Initial View: The view that appears when you launch Calendar.
• Button Views: The views that appear when you press Calendar repeatedly. By default, you see Day and Month Views, but you can also see Week, Week with Text, Year, and Daily Journal Views.

• Display Options: Your choices for different Calendar view options:
  • Show Time Bars: Shows the duration of an event and illustrates conflicts.
  • Compress Day View: When off, all time slots display. When on, start and end times display for each event, but blank time slots disappear to minimize scrolling.
  • Show PM Label: Displays a p after PM times.
  • Show End Times: Displays all time bars and time slots for end times of an event.
  • Auto-scroll Time: Displays events based on the time of day when there is more than one screen of information. The arrows at the bottom-right corner indicate more information.
  • Float Advance at Midnight: Advances floating events to the next day at midnight of the current day.
  • Show Completed Floating Events: Displays completed floating events.

4. Choose OK to close the Display options dialog.
5. Choose OK.
Customizing To Do List preferences for your calendar

You can display To Do items in your calendar to keep on top of your tasks.

1. Press Calendar until you are in Day view.
2. Press Menu.
3. From the Options menu, choose To Do Preferences.
4. Set any of the following preferences:

   - Show Categories: Determines which To Do categories appear.
   - Priorities Displayed: Limits the To Do items to certain priorities.
   - Show Priority: Displays the priority assigned to an item.
   - Show Completed Items: Displays checked off items.
   - Show Undated Items: Displays items that do not have a Due Date assigned.
   - Show Dated Items: Displays To Do items that have a Due Date assigned.

5. Choose OK.
To Do List

You can use To Do List as a reminder of tasks you need to complete and to keep a record of complete tasks.

Adding a To Do item
1. Press Applications Launcher  
2. Choose the pick list in the upper-right corner, then select All.
3. Choose the To Do List icon.
4. Choose New to create a new To Do item
5. Type the text of the To Do item. The text can be longer than one line.

You can set To Do List to record the date that you completed the To Do item, and you can choose to show or hide completed items. Completed items remain in the memory of your phone until you purge them.

To save memory, you can purge all completed To Do items. From the Record menu, choose Purge. Choose OK to finish.

You can display To Do items in your calendar. See page 87 for information on customizing To Do Preferences for your calendar.
Setting item priority, due date, and other details
The Details dialog enables you to assign a priority level, due date, category, privacy flag, and note to each item.
1. Highlight the item to which you want to assign details.
2. Choose Details.
3. Set any of the following:
   • Priority: Choose the Priority number for this item (1 is most important). Later you can arrange your To Do items based on the importance of each item.
   • Category: Assign the item to a specific category.
   • Due Date: Choose the Due Date pick list, then select a due date for the item.
   • Private: Check this box to mark this item private.
   • Note: Enter additional text you want to associate with the item.
4. Choose OK.
Checking off a To Do item
1. Choose the item you want to check off.

Deleting a To Do item
1. Highlight the item you want to delete.
2. Press Menu ⌃
3. From the Record menu, choose Delete Item (/D).
4. Choose OK.

Customizing To Do List
The To Do Preferences screen enables you to control the appearance of To Do List.
1. In To Do List, choose Show.
2. Set any of the following preferences:

<table>
<thead>
<tr>
<th>To Do Preferences</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Sort by: Priority, Due Date</td>
<td></td>
</tr>
<tr>
<td>Show Completed Items</td>
<td></td>
</tr>
<tr>
<td>Show Only Due Items</td>
<td></td>
</tr>
<tr>
<td>Record Completion Date</td>
<td></td>
</tr>
<tr>
<td>Show Due Dates</td>
<td></td>
</tr>
<tr>
<td>Show Priorities</td>
<td></td>
</tr>
<tr>
<td>Show Categories</td>
<td></td>
</tr>
</tbody>
</table>

- Sort by: Indicates the order in which your To Do items appear in the list.
- Show Completed Items: Displays items you've checked off.
- Show Only Due Items: Hides items that are not yet due.
- Record Complete Date: Replaces due date with the completion date when you complete (check) the item.
• Show Due Dates: Displays item due dates, and inserts an exclamation mark next to overdue items.
• Show Priorities: Displays the priority setting for each item.
• Show Categories: Displays the category for each item.
3. Choose OK.
Memo Pad

Memos are a great way to store notes on your Treo.

Creating a memo
1. Press Applications Launcher ( indis).
2. Choose the pick list in the upper-right corner, then select All.
3. Choose the Memo Pad icon.
4. Enter the text you want to appear in the memo.
5. Choose Done.

Deleting a memo
1. Choose the memo you want to delete.
2. Press Menu ( indis).
3. From the Record menu, choose Delete Item (/ D).
4. Choose OK.
CityTime

The CityTime world clock displays the day and time in your home city and in four other cities around the globe. Whether you're traveling or at home, it's easy to keep track of the best time to reach your business associates, friends, and family in faraway places.

Setting your Home City

The Home City serves as a point of reference for your other city selections. The Home City time reflects the current system time (unless you have changed locations, see page 94). The information displayed for all the other cities is based on the day and time in your Home City.

1. Press Applications Launcher.
2. Choose the pick list in the upper-right corner, then select All.
3. Choose the CityTime icon.
4. Press Menu.
5. From the Options menu, choose Select Home City (/H).
6. Choose the Home City pick list, then select the city closest to your location (in the same time zone).
7. Choose OK.

CityTime

A. Home City
Selecting remote cities
In addition to your Home City, you can display the day and time for four other cities, called remote cities, anywhere around the globe.
1. Use the stylus to tap a pick list in the lower part of the CityTime screen, then select the city closest to the city you want to display.
2. Choose the remaining pick lists, then select the other three cities you want to display.

Adding cities
If the city you want to display is not in the predefined list, you can add it.
1. Press Menu.
2. From the Options menu, choose Edit Cities (/ E).
3. Choose New.
4. Enter the city name and other information.
5. Choose OK.

Changing locations
If you travel, you can easily coordinate the system time on your Treo with the local time.
1. Press Menu.
2. From the Utilities menu, choose Change Location (/ L).
3. Choose the To pick list, then select your new location.
4. Choose OK.
Calculator

Calculator includes a basic calculator, plus an advanced calculator with scientific, financial, and conversion functions.

Switching between Basic and Advanced Calculator modes

1. Press Applications Launcher.
2. Choose the pick list in the upper-right corner, then select All.
3. Choose the Calculator icon.
4. Press Menu.
5. From the Options menu, choose Toggle Mode (/ M).

You can tap the screen or use the keyboard to input numbers.
Selecting functions in Advanced Calculator mode
1. Switch to Advanced Calculator mode (see above).
2. Choose the pick list near the upper-left part of the screen, then select the Advanced Calculator function you would like to use:
   - Math: Advanced mathematical functions such as exponents, roots, and logarithms.
   - Trig: Trigonometric functions such as sine, cosine, tangent, and variants.
   - Finance: Financial calculator functions such as APR and amortization.
   - Logic: Hexadecimal characters in keypad, plus logic functions such as and, not, or, and xor. In place of Float/Degrees (see below), this view includes options for class (bin, oct, SDec, UDec, hex) and bits (8, 16, 32).
   - Statistics: Statistical functions such as sum, factorial, and random number generator.
   - Weight/Temp: Weight and temperature conversions for metric and English values.
   - Length: Length conversions for metric and English values.
   - Area: Area conversions for metric, traditional, and English values.
   - Volume: Volume conversions for metric and English values.

Choose Sto to store a number in one of ten memory slots. Choose Rcl to recall a stored number.

Choose Con to access a list of mathematical constants such as Avogadro’s number or the speed of light.
3. Choose the pick list near the upper-middle of the screen, then select how to display decimal values:

- **Float (Floating point):** Position of decimal point varies according to calculation results.
- **Fixed(x) (Fixed point):** Enter an integer for the number of decimal places to display, then select Fixed(x) to round calculations to that decimal place.
- **Sci(x) (Scientific notation):** Enter an integer for the number of decimal places to display, then select Sci(x) to round calculations to that decimal place using scientific notation.
- **Eng(x) (Engineering notation):** Enter an integer for the number of decimal places to display, then select Eng(x) to round calculations to that decimal place using engineering notation.

4. Choose the pick list near the upper-right of the screen, then select whether you want to display numbers in degrees, radians, or grads.
Looking up contacts and other information

With the built-in search features on your Treo, you can find information quickly:
- Name Lookup: Enables you to dial your Contacts by name. It locates people's phone numbers when you're in the Contacts list.
- Find: Searches through the text in all the applications on your Treo.

Name Lookup
You can access Name Lookup directly from the Contacts list. This feature helps you locate Contacts quickly by entering just a few letters of a Contact's name.
1. Press Phone.
2. Use the 5-way navigation control to access the Contacts list.
3. From the Contacts list, enter the first few letters of the Contact you want to find.
   You can enter:
   - First name (joh for John) or
   - Last name (smi for Smith) or
   - First name initial and last name (jsm for John Smith)
For example, entering SM displays Smilla Anderson, John Smith, and Sally Martin as shown above. Entering JSM finds only John Smith.

4. Do one of the following:
   - Highlight the contact name, then press Center to view the contents of the record.
   - Highlight any phone number, then press Center to dial.

Using Find

The Find feature locates any text in the built-in applications and databases, and in some third-party applications. The Find feature performs an exact search on a character string, including characters that are parts of words.

1. Press Option , then Shift  to open the Find dialog.
2. Enter the text you want to find.
3. Choose OK to start the search.
4. In the search results, choose the text you want to review, or choose Find More to search additional applications.
Beaming information

Your Treo is equipped with an IR (infrared) port that lets you beam information to another Palm Powered™ device with an IR port. The IR port is located on the top of your Treo, between the Wireless Mode button and the ringer switch, behind the small dark shield.

Beaming a record
1. Choose the record or category you want to beam.
2. Press Menu.
3. From the Record menu, choose one of the following:
   • Beam (/B): Sends an individual record.
   • Beam Category (/Y): Sends all records in the current category.
4. When the Beam Status dialog appears, point the IR port on your Treo directly at the IR port of the receiving device.
5. Wait for the Beam Status dialog to indicate that the transfer is complete before you continue using your Treo.

You can store a beamed application on your phone, or send it to an expansion card inserted in the expansion slot.

Beam your business card in two key presses: in any Phone view, press Menu, then press M.
Beaming an application

Not all applications can be beamed. A lock icon 🗝️ appears on the Beam screen next to applications that cannot be beamed.

1. Press Applications Launcher 📱.
2. Press Menu 📲.
3. From the App menu, choose Beam (/B).
4. Choose the Beam From pick list, then select whether the application you want to beam is located on your Treo or an expansion card.
5. Choose the application you want to transfer.
6. Choose Beam.
7. When the Beam Status dialog appears, point the IR port on your Treo directly at the IR port of the receiving device.
8. Wait for the Beam Status dialog to indicate that the transfer is complete before you continue using your Treo.

For best results, the path between the two devices must be clear of obstacles, and both devices must be kept stationary. If you have difficulty beaming, shorten the distance and avoid bright sunlight.

If you do not choose a category upon receiving a beamed item, the item is placed in the Unfiled category.

If you can't receive beamed information, try a soft reset (see page 141).
Receiving beamed information
1. Turn on your screen.
2. Point the IR port on your Treo directly at the IR port of the transmitting device to open the Beam Status dialog.
3. When the Beam dialog appears, choose a category for the entry.
4. Press Up ▲ to receive the beam or press Down▼ to refuse it.
first month: managing applications
Installing applications

Your Treo™ 600 smartphone comes with several built-in applications that are ready to use. You can also install third-party Palm OS® applications, such as business software, games, and more. To learn more, go to www.palmOne.com/software.

When you download an application to your computer, it is probably in a compressed format such as a .zip or .sit file. If the file is compressed, you need to use a decompression utility on your computer before you install the application on your Treo.

These instructions tell you how to install basic .prc (Palm OS application) and .pdb (Palm OS database) files onto your Treo. Some Palm OS software uses an installer or wizard to guide you through the process. Consult the documentation that came with the software for details.

Installing applications from the Internet
You can install Palm OS applications, images, and ringtones directly from the Internet, using Blazer® Web Browser. When you download an application, it automatically installs on your Treo. Remember: Palm OS applications have .prc or .pdb at the end of their file names.

1. Press Applications Launcher .
2. Choose Downloads.
3. Go to the page that contains the link to the application you want to download.
4. Press Left or Right to highlight the link to the file, then choose Download to initiate the download process.
Installing applications from a Windows computer

1. Double-click the .prc or .pdb file you want to install on your Treo.
2. A dialog may appear with a User drop-down list. Select your User Name from the list.
3. The Install Tool window appears. If you would like to install additional files, simply drag and drop them into the space in this window.
4. If you want to install an application to an expansion card, click Change Destination. Click the arrows to move the application to the expansion card pane, then click OK.
5. Click Done.
6. Perform a HotSync® operation to install the application(s) on your Treo.

Before you can install an application on your Treo, you need to have Palm® Desktop software installed on your computer (see page 30).
Installing applications from a Macintosh computer

1. On your Macintosh, launch Palm Desktop.
2. From the HotSync menu, choose Install Handheld Files.
3. Select the User Name that corresponds to your Treo phone from the User drop-down menu.
4. Click Add To List.
5. Locate the .prc or .pdb file you want to install on your Treo. Highlight it and click Add File.
6. Perform a HotSync operation to install the application(s) on your Treo.

Getting help with third-party applications

If you encounter a problem (such as an error message) with a third-party application, contact the application’s author or vendor. For general troubleshooting of third-party applications, see page 152.
Removing applications

If you decide that you no longer need an application, or want to free up memory on your Treo, you can remove applications from your Treo or an expansion card (for more on expansion cards, see page 111). You can remove only applications, patches, and extensions that you install; you cannot remove the built-in applications that reside in the ROM portion of your Treo.

1. Press Applications Launcher.
2. Press Menu.
3. From the Options menu, choose Delete (/D).
4. If you want to remove an application from an expansion card, insert the card into your Treo.
5. Choose the Delete From pick list, then select the location of the application you want to remove.
6. Choose the application that you want to remove.
7. Choose Delete to finish.
8. Perform a HotSync operation to remove the application from the Backup folder on your computer.

If the application re-appears on your device, you may need to manually delete it from your computer. Locate your Backup folder on your computer (Windows: C:\Program Files\palmOne\user name; Macintosh: Mac HD\Applications\palmOne\Users\user name). If you find a .prc or .pdb file for the application you just removed, delete the file from the Backup folder.
Using Application Info

The Info screens display basic statistics about the applications on your Treo.

1. Press Applications Launcher.
2. Press Menu.
3. From the App menu, choose Info.
4. At the bottom of the screen, choose the type of information you want to view:
   - Version: The version numbers of applications on your Treo.
   - Size: The size (in kilobytes) of applications and data on your Treo.
   - Records: The number of records in different applications on your Treo.
5. Choose Done.
Using expansion cards

The expansion slot on your Treo enables you to add Secure Digital (SD™) cards and MultiMedia™ Cards (MMC) to extend the storage capacity of your Treo. For example, SD or MMC expansion cards can store:

- pictures
- MP3 audio files
- games
- eBooks
- applications
- databases
- ... and more

Although expansion cards are sold separately, your Treo includes a mock, non-functional card inside the expansion slot. When you’re not using a functioning card, reinsert the mock card that came with your Treo to protect the expansion slot opening and to keep the slot clean.

Inserting and removing expansion cards

1. Press down and release the mock card.
2. After the expansion slot ejects the mock card, remove the card from the slot.

SD cards are faster than MMC cards for reading and writing data.

Warranty does not cover damage by Secure Digital (SD) cards that do not meet SD Memory Card Specifications. SD cards that do not meet SD Memory Card Specifications may damage Treo 600.
3. Hold your Treo with the screen facing you, and the card with the notch in the lower-right corner next to the stylus.

4. Insert the card into the expansion slot until you feel the card lock into place and hear the confirmation tone.

Launching applications on an expansion card

After you insert an expansion card in the expansion slot, you can launch any of the applications stored on the expansion card.

1. Insert the expansion card into the expansion slot. The Applications Launcher automatically appears.

2. Choose the icon for the application you want to launch.

3. Press Center to launch the application.
Copying applications to an expansion card
You can copy applications between your Treo and your expansion card.

1. Press Applications Launcher ( ).
2. Press Menu ( ).
3. From the App menu, choose Copy (Copy). (I/C).
4. Choose the Copy To pick list, then select the destination: card name or Phone.
5. Choose the From pick list, then select the location of the application you want to
   copy: card name or Phone.
6. Highlight the application you want to copy.
7. Choose Copy to finish.

Before you copy an application to an expansion card, make sure that it is
compatible with Palm OS version 5.2 or higher. Some applications do not work
with expansion cards and do not allow you to store data files in a location that
is separate from the application.
Viewing expansion card information
The Card Info application displays general information about the expansion card that is currently in the expansion slot.
1. Press Applications Launcher.
2. Choose the pick list in the upper-right corner, then select All.
3. Choose the Card Info icon.

Renaming an expansion card
If you change the contents of an expansion card, you may want to rename the card to better match its contents.
1. Insert the expansion card into the expansion slot. The Applications Launcher automatically appears.
2. Choose the Card Info icon.
3. Press Menu.
5. Type a new name for the card.
6. Choose OK.

Formatting an expansion card
Formatting an expansion card is similar to formatting a disk on a computer. When you format an expansion card, you erase all the data stored on the card.
1. Insert the expansion card into the expansion slot. The Applications Launcher automatically appears.
2. Choose the pick list in the upper-right corner, then select All.
3. Choose the Card Info icon.
4. Press Menu.
5. From the Card menu, choose Format Card (/ F).
6. Type a new name for the card.
7. Choose OK.
when you’re ready: customizing your Treo™
Phone settings

Selecting ringtones and messaging alert tones
You can set different tones and volumes for incoming phone calls, Calendar alarms, and MMS and SMS messaging alerts.

1. Press Applications Launcher.
2. Choose the pick list in the upper-right corner, then select All.
3. Choose the Prefs icon.
4. Choose the pick list in the upper-right corner, then select Sound.
5. Choose the Application pick list, then select Phone, Calendar, MMS, or SMS.
6. Choose the Volume box.
7. Choose each pick list, then select an alert volume.
8. Choose the Tones box.
9. Depending on the application, select alert tones from the pick lists that appear:
   • Phone
     • Known Caller Tone: An incoming call from someone in your Contacts or Favorites.
     • Unknown Caller Tone: An incoming call from someone identified by Caller ID who is not in your Contacts or Favorites.
     • Roaming Tone: A special tone for incoming calls when you’re outside your home mobile network.
     • Voicemail Tone: A new voicemail.

You can also adjust the ringer volume by pressing the volume buttons when you’re not on an active call.

Want more ringtones? You can download them from the web to your phone (see page 59).
- Service Tone: A warning of a service change, such as moving into and out of a mobile network coverage area.

- Calendar
  - Alarm Sound: The tone played the first time your alarm goes off.
  - Reminder Sound: The tone played if an alarm is not acknowledged and the alarm repeats.
  - Play Sound: The number of times an alert tone will play during the alarm sequence.
  - Repeat Alarm: The number of times the alarm repeats if not acknowledged.
  - Every: The interval between alarm repeats if not acknowledged.
  - Alarm Preset: A default for the number of minutes, hours, or days before the event that the alarm goes off.

- MMS
  - Message Tone: A new multimedia message arrives.

- SMS
  - Message Tone: A new text message arrives.

Adjusting call volume
While on an active call, or while using the personal speakerphone, press the volume buttons on the side of your Treo™ 600 smartphone to adjust call volume.
Assigning a caller ID picture and ringtone

1. Press Phone.
2. Press Up to access your Favorites buttons.
3. Highlight the Favorites button you want to give a picture caller ID.
4. Press Menu.
5. From the Edit menu, choose Edit Favorites Button (/ E).
7. Check the Image box, then choose Select Image.
8. Choose the picture you want to assign to the selected Favorites button.
9. Choose Select.
10. Choose the ringtone pick list, then select a caller ID ringtone.
11. Choose OK.

If you prefer to use the onscreen Dial Pad, assign the Dial Pad as the default wallpaper.

If you remove the Dial Pad as the wallpaper, you can still access it quickly. Press Phone, then press Center.
Choosing wallpaper for the Phone screen

If you have images stored on your Treo, you can select different wallpaper for the Main view in the Phone application.

1. Press Phone.
2. Press Menu.
3. From the Options menu, choose Display Preferences.
4. Choose the pick list at the top of the screen, then select Show Wallpaper.
5. Choose the current wallpaper image, then choose a wallpaper image for your Phone screen.
6. Choose Select.
7. OK.
You can immediately silence all sounds on your Treo, including phone ringtones, Calendar alerts, and system sounds. This does not mute the speaker on your Treo during a phone call.

1. Slide the ringer switch to Sound Mode Off.
2. To hear all sounds again, slide the ringer switch to Sound Mode On.

When you slide the ringer switch back to the Sound Mode On position, it restores the previous sound settings. For example, if the Phone ring volume is set to 7 and you slide the ringer switch to Sound Mode Off, you will not hear the phone ring.

When you move the ringer switch back to Sound Mode On, the Phone ring volume is still set to 7.

If the ringer switch is set to no sound, the ringer setting overrides the sound settings and all sounds are turned off.

Your Treo includes a silent alarm that can vibrate even when the ringer switch is set to Sound Mode Off.

A. Sound Mode On
B. Sound Mode Off
Display and appearance

Turning the keyboard backlight on and off
- To turn the keyboard backlight on, press Option , then . The backlight illuminates the keys, and the screen dims slightly.
- To turn the keyboard backlight off, press Option , then again.

Adjusting the contrast and brightness
Depending on the lighting conditions where you're using your Treo, you may need to adjust the screen contrast and brightness.
1. Press Applications Launcher .
2. Choose the pick list in the upper-right corner, then select All.
3. Choose the Prefs icon.
4. Choose the pick list in the upper-right corner, then select Display.
5. Choose the slider, and use Left  and Right  to adjust brightness.
6. Choose the slider , and use Left  and Right  to adjust contrast.
Changing the screen font
You can change the font in Calendar, Contacts, Memo Pad, SMS, and To Do List.
1. Launch the application in which you want to change the font.
2. Press Menu.
3. From the Options menu, choose Font (/F).
4. Choose a font style:
   A. Small font
   B. Small bold font
   C. Large font
   D. Large bold font
5. Choose OK.

Aligning the touchscreen
If you tap the touchscreen and your Treo doesn’t respond accurately or activates the wrong feature, you may need to realign your touchscreen.
1. Press Applications Launcher.
2. Choose the pick list in the upper-right corner, then select All.
3. Choose the Prefs icon.
4. Choose the pick list in the upper-right corner, then select Touchscreen.
5. Follow the onscreen instructions.

Changing the system color scheme
1. Press Applications Launcher.
2. Choose the pick list in the upper-right corner, then select All.
3. Choose the Prefs icon.
4. Choose the pick list in the upper-right corner, then select General.
5. Choose the Colors pick list, then select a color scheme.
Applications Launcher settings

Arranging applications by category
You can assign an application to a category and then display a specific category of applications in the Applications Launcher.
1. Press Applications Launcher.
2. Press Menu.
3. From the App menu, choose Category (/Y).

4. Choose the pick list next to each application, then select a category.
5. Choose Done.

Displaying applications by category
Do one of the following:
• Press Applications Launcher repeatedly to cycle through the categories.
• Choose the pick list in the upper-right corner, then select a category.
You can use Buttons Preferences to choose which applications are associated with the buttons on your Treo.

1. Press Applications Launcher .
2. Choose the pick list in the upper-right corner, then select All.
3. Choose the Prefs icon.
4. Choose the pick list in the upper-right corner, then select Buttons.
5. Choose the pick list next to the button or key combination you want to reassign, then select an application.

If you install a new Email, Messaging, or Browser application on your Treo, it appears in the default application pick lists if the application supports this feature. Some third-party applications automatically assign themselves to a particular button. For example, email applications typically take over the SMS button.

<table>
<thead>
<tr>
<th>Buttons Preferences</th>
<th>Buttons Preferences</th>
</tr>
</thead>
<tbody>
<tr>
<td>Precedence Button</td>
<td>Optimize Button</td>
</tr>
<tr>
<td>Phone</td>
<td>Yes</td>
</tr>
<tr>
<td>Contacts</td>
<td>Memoized</td>
</tr>
<tr>
<td>SMS</td>
<td>Blues</td>
</tr>
<tr>
<td>Power</td>
<td>Keyguard</td>
</tr>
<tr>
<td>Default: HotSync...</td>
<td></td>
</tr>
</tbody>
</table>
Setting default applications

Some applications look for other applications to handle data (for example, a mail application might launch a browser when you choose a link in an email message).

1. Press Applications Launcher.
2. Choose the pick list in the upper right comer, then select All.
3. Choose the Prefs icon.
4. Choose the pick list in the upper-right corner, then select Default Apps.
5. Choose each pick list, then select the application you want to associate with that function.
Date and time settings

Setting the date and time

You can use Date & Time Preferences to set the time, date, time zone, and daylight savings setting for your Treo. By default, your phone synchronizes the date and time with the Verizon network when Wireless Mode is on and you're inside a coverage area.

To manually set the date and time, follow these steps:
1. Press Applications Launcher ( ).
2. Choose the pick list in the upper-right corner, then select All.
3. Choose the Prefs icon.
4. Choose the pick list in the upper-right corner, then select Date & Time.
5. Uncheck the Enable Local Network Time box.
6. Choose the Set Date box. Highlight the current year, month, and date, then press Center to set the date.
7. Choose the Set Time box. Using the stylus, tap the up and down arrows to select the current time, then choose OK to set the time.
8. Choose the Set Time Zone box. Choose the time zone for your location, then choose OK.
9. Choose the Daylight Saving pick list, then select On or Off.
Setting date and time formats

You can use Formats Preferences to choose number conventions based on geographic regions. For example, in the United Kingdom, time is expressed using a 24-hour clock. In the United States, time is expressed using a 12-hour clock with an AM or PM suffix. All the built-in applications on your Treo use the Format Preferences settings.

1. Press Applications Launcher ( ).
2. Choose the pick list in the upper-right corner, then select All.
3. Choose the Prefs icon.
4. Choose the pick list in the upper-right corner, then select Formats.
5. Set any of the following preferences:
   - Preset to: The standard number conventions for your country. When you select a country, the other Formats Preferences are automatically set to that country's conventions. You can also edit each option individually.
   - Time: The time format. Select H H : M M to display a 24-hour clock.
   - Date: The date format.
   - Week starts: The first day of the week (usually Sunday or Monday).
6. Numbers: The format for numbers with decimal points and commas.
General Preferences

You can use General Preferences to set the auto shutoff interval, the beam receive feature, sounds, and screen colors for your Treo.

1. Press Applications Launcher ②.
2. Choose the pick list in the upper-right corner, then select All.
3. Choose the Prefs icon.
4. Choose the pick list in the upper-right corner, then select General.

5. Set any of the following preferences:
   - Auto-off After: The time that elapses before your screen turns off automatically.
   - System Sound: The volume for system beeps and alerts.
   - Game Sound: The volume for game sounds.
   - Beam Receive: The setting that determines if your Treo can receive beamed information.
   - Colors: The set of predefined colors for the system display.
Locking your phone and data

Your Treo includes several features that help you protect your phone from inadvertent use and keep your data private. The built-in security software enables you to use your Treo for emergency calls even if the handset is locked.

- **Keyguard**: Manually disables all buttons and the touchscreen to prevent them from being pressed accidentally in your briefcase or pocket.
- **Auto-Keyguard and touchscreen lockout**: Automatically enables Keyguard after a period of inactivity, and lets you disable the touchscreen during an active call or call alert.
- **Phone Lock**: Requires a password to make calls with your phone.
- **System password lock**: Requires a password to see any data on your Treo.
- **Private records**: Masks or hides items marked as private, and requires a password to view them.

When you receive or make a call, the touchscreen on the Active call screen may be automatically disabled to prevent accidental termination of a call. You must use the 5-way navigation control to access the buttons on the Active call screen. Check the Keyguard settings in Preferences.
Keyguard
Your Treo includes a feature that locks the keyboard, so that screen items and buttons aren't accidentally pressed while the phone is in a pocket or bag.

1. With the Treo screen on, press Option and the Screen button to enable Keyguard.
2. To disable Keyguard, press Center.

Auto-Keyguard and touchscreen lockout
Auto-Keyguard lets you automatically lock the keyboard after a period of inactivity.

1. Press Applications Launcher.
2. Choose the pick list in the upper-right corner, then select All.
3. Choose the Prefs icon.
4. Choose the pick list in the upper-right corner, then select Keyguard.
5. Set any of the following preferences:
   - Auto-Keyguard: The period of inactivity that passes before the keyboard automatically locks.
   - Disable touchscreen when: The conditions in which the touchscreen disables.
Phone Lock

You can lock your phone to prevent unauthorized use of your mobile account. When your phone is locked, you must enter the correct Lock Code to make calls. You can, however, still place emergency calls when you phone is locked, and you can also receive calls.

1. Press Phone.
2. Press Menu.
3. From the Options menu, choose Phone Lock (/L).
4. Choose one of the following Lock Wireless Mode options:
   - On Wireless Mode power off: Locks your phone each time you turn off Wireless Mode. When this setting is active, you must enter your lock code each time you turn Wireless Mode on again.
   - Immediately: Locks your phone when you choose OK. The next time you turn Wireless Mode on you must enter your lock code. After that, you can turn Wireless Mode on again without entering your lock code.
5. When prompted, enter the current Lock Code and choose OK. Unless you changed your Lock Code, enter the default Lock code, which is the last four digits of your phone number.
6. If you want to change the Lock Code, choose Change Lock Code, enter a new Lock Code, then choose OK to accept it. Repeat this step to verify the new Lock Code.
7. Choose Advanced to specify three emergency numbers that you can dial even when your phone is locked.

Important: If you lock your system, you must enter the exact password to unlock it. If you forget the password, you need to perform a hard reset to use your phone. Performing a hard reset deletes all the records in your phone (see page 142). However, you can restore all previously synchronized data at the next HotSync operation (see page 31).

To lock your system manually, choose Lock & Turn Off, and then choose Off & Lock.
System password lock
You can protect your personal information by locking the system so that a password is required to access any data or use other features of your Treo.

1. Press Applications Launcher.
2. Choose the pick list in the upper-right corner, then select All.
3. Choose the Security icon.
4. Choose the Password box.
5. Assign a password and a password hint to your Treo.
6. Choose the Auto Lock Handheld box.
7. When prompted, enter your password.
8. Choose one of the following options:
   - Never: Prevents your Treo from locking automatically.
   - On power off: Locks your Treo when you turn off the screen, or when it shuts off with the auto-off feature.
   - At a preset time: Locks your Treo at a specific time of day.
   - After a preset delay: Locks your Treo after a period of inactivity.
Setting Owner Preferences

You can use Owner Preferences to record information such as your name, company name, and phone number. If you lock your keyboard, the Owner Preferences information appears on the screen that requests your password to unlock it, and you must also enter your password to change the Owner Preferences information.

1. Press Applications Launcher (⑩).
2. Choose the pick list in the upper-right corner, then select All.
3. Choose the Prefs icon.
4. Choose the pick list in the upper-right corner, then select Owner.
5. If you assigned a password with the Security application, choose Unlock, enter your password, then choose OK to continue.
6. Type the text that you want to appear in the Owner Preferences screen.
Private records
In most applications you can mark individual entries as private. All private entries remain visible and accessible until you select the Security setting to hide or mask them. When you hide entries, they do not appear anywhere in the application. When you mask entries, a visual placeholder appears in place of the entry. If you define a password, you must enter it to display private entries. If you do not define a password, you (or anyone else) can reveal private entries without a password.

1. Display the entry that you want to mark private.
2. Choose Details.
3. Check the Private box.
4. Choose OK.

Hiding or masking all private records
1. Make sure the records you want to mask are marked private.
2. Press Applications Launcher  
3. Choose the pick list in the upper-right corner, then select All.
5. Choose the Current Privacy pick list, then select either Hide Records or Mask Records.

As a security measure, masked Contacts records are temporarily hidden when you perform a search. So you will not see a placeholder for masked entries when viewing the results of a Lookup or Find request.
Viewing all private records
1. Make sure the records you want to mask are marked private.
2. Press Applications Launcher  
3. Choose the pick list in the upper-right corner, then select All.
5. Choose the Current Privacy pick list, then select Show Records.
6. If the Show Private Records dialog appears, enter your password, then choose OK.

Viewing private entries in a specific application
1. Launch the application that contains the private entries you want to display.
2. Press Menu  
3. From the Options menu, choose Security (/H).
4. Choose the Current Privacy pick list, then select Show Records.
5. Choose OK.
Security and Palm® Desktop (Windows)

Palm Desktop for Windows observes the security password for your Treo. If you forget your Treo password, you cannot view your data in Palm Desktop. You can change your password, but all records marked as Private will be deleted. You can restore these records at the next HotSync operation.

1. Press Applications Launcher.
2. Choose the pick list in the upper-right corner, then select All.
3. Choose the Security icon.
4. Choose the Password box.
5. Choose the Lost Password box.
6. Choose Yes.

If you want additional security for Palm Desktop files, you can purchase a third-party solution.
if something happens:
help
Upgrading from another Palm Powered™ device

To transfer all compatible applications and data from your previous device to your new Treo™ 600 smartphone:

1. Perform a HotSync® operation with your old device and your old desktop software to back up your data one last time.

2. Install Palm® Desktop software from the CD that came with your Treo (see page 30). During the installation process, perform a HotSync operation with your new Treo. When prompted to choose a user name for your new Treo, be sure to select the existing user name for your old device.

3. Some third-party applications may be quarantined by HotSync Manager because they are not compatible with the Palm OS® 5.2 on your Treo. Do not manually install any quarantined files (see the documentation that came with the third-party applications for more information).

4. If you plan to continue using your old device, perform a hard reset (see page 141) to remove its associated user name. Each device you synchronize with your computer must have a unique name. The next time you synchronize with your old device, be sure to assign it a new user name.

After upgrading, there are a few things you need to know about your new Treo:

- Address Book: This application is now called Contacts. To launch Contacts, press Phone ◯, then use the 5-way navigation control to choose Contacts.
- Date Book+: This application is now called Calendar. To access this application, press Calendar ◯.

Always use the same language for your Treo and your desktop software. Otherwise, you may lose data.
• Applications Launcher: Some previous Palm Powered™ devices called this the Home screen. To access this screen, press Applications Launcher ⬤.
• Find: Some previous Palm Powered devices launched this global search engine by tapping the magnifying glass icon in the Graffiti® area. Now you can access it by pressing Option ⬤ and Shift ⬤ together.
• Menu commands: Users familiar with Graffiti's Menu launch command can now access system menus by pressing Menu ⬤ (see page 21).
• Backlight: Treo includes a keyboard backlight that also dims the screen slightly for low light conditions. While your Treo screen is on, press Option ⬤, then P to turn on the keyboard backlight.
• Center button: If you used an earlier model Treo, you might be accustomed to pressing Spacebar to activate commands or dial numbers. With this Treo, we recommend pressing Center instead.
• Screen button: The fourth button on the right is used to control the screen and is not an application button. However, you can remap this button to your favorite application (see page 124).
• Internet connection: This Treo was designed to work on high speed wireless data networks. When you sign up for a high speed wireless data account, these settings are automatically configured on your Treo.
• 5-way navigation compatibility: Some Palm OS 5 applications are optimized for 5-way navigation on devices other than Treo. Therefore you may notice inconsistencies with software that is not optimized for Treo.
Trouble installing Palm Desktop?

The CD included with your Treo installs the software and drivers that let you synchronize with Palm Desktop software or Microsoft Outlook for Windows. If you want to synchronize with a different Personal Information Manager (PIM), you must install a third-party solution. Contact the PIM's author or vendor to learn if software is available for your Treo.

1. Restart your computer.
2. Quit any active applications, including virus scanners and Internet security applications.
3. Make sure you're installing the version of Palm Desktop software that came on the CD with your Treo. Other versions of Palm Desktop software may not work with this Treo.
4. Make sure your computer profile includes administrator rights to install software. In large organizations, these are usually granted by the system administrator.
Resetting your Treo

Soft reset
A soft reset is similar to restarting a computer. If your Treo is not responding or you have trouble synchronizing with your computer, a soft reset may help. Unless your battery is extremely low, a soft reset should not affect your data.
1. Unscrew the stylus tip to access the reset tool.
2. Use the reset tool to gently press the reset button on the back of your Treo.

System reset
A system reset, also called a safe or warm reset, tells your Treo to stop what it’s doing and start over again without loading any system extras. If your Treo loops or freezes during a soft reset, a system reset may help. Performing a system reset allows you to get out of an endless loop so that you can uninstall the third-party application that caused the loop. Unless your battery is extremely low, a system reset should not affect your data.
1. Unscrew the stylus tip to access the reset tool.
2. While holding Up ▲, use the reset tool to gently press the reset button on the back of your Treo.
3. When the Palm Powered logo appears, release Up ▲.

Hard reset

A hard reset erases all data and third-party software on your Treo. Never perform a hard reset without first trying a soft and system reset. You can restore previously synchronized data with the next HotSync operation.

A hard reset can tell you whether a problem is caused by your Treo or an application installed on your Treo. If a hard reset eliminates the problem, the problem may have been caused by software you installed on your Treo. See page 152 for suggestions on diagnosing third-party software issues.

1. Unscrew the stylus tip to access the reset tool.
2. While holding the Wireless Mode button ▲, use the reset tool to gently press the reset button on the back of your Treo.
3. When the Palm Powered logo appears, release the Wireless Mode button ▲.
4. When the warning appears, press Up ▲ to confirm the hard reset.
5. If a language selection screen appears, choose the same language you selected for your desktop software.
Screen

The screen appears blank
1. Look closely at the screen. If you can see a dim image, try adjusting the screen contrast and brightness (see page 121).
2. If adjusting the contrast and brightness doesn’t resolve the problem, perform a soft reset (see page 141).
3. If performing a soft reset doesn’t resolve the problem, connect the Treo to the AC charger (see page 11) and perform a soft reset again.
4. If another soft reset doesn’t resolve the problem, perform a hard reset (see page 142).

The screen doesn’t respond accurately to taps or the wrong features are activated
1. Press Applications Launcher.
2. Choose the pick list in the upper-right corner, then select All.
3. Choose the Prefs icon.
4. Choose the pick list in the upper-right corner, then select Touchscreen.
5. Follow the onscreen instructions to recalibrate the touchscreen.
Network connection

Signal strength is weak
1. If standing, move about 10 feet in any direction.
2. If you are in a building, move near a window. Open any metal blinds.
3. If you are in a building, move outdoors or to a more open area.
4. If you are outdoors, move away from large buildings, trees, or electrical wires.
5. If you are in a vehicle, move your Treo level with a window.

Treo won’t connect to the mobile network
1. Try our suggestions above for weak signals.
2. Turn off Wireless Mode and turn it on again (see page 13).
3. Perform a soft reset (see page 141).

Treo hangs up when I hold it to my ear
You may be accidentally pressing the onscreen Hang Up All button with your cheek. Try holding the phone so your face doesn’t press against the screen. If this is not convenient, you may want to disable the touchscreen during active calls (see page 130).

Treo makes or answers calls when it’s in a briefcase or pocket
Items in your briefcase or pocket may be pressing the onscreen Answer button, or otherwise activating screen items. If this happens, you may want to disable the touchscreen during incoming calls (see page 130).

Become familiar with low coverage areas where you live, commute, work, and play. Then, you will know when to expect signal strength issues.
I can't tell if data services are available

- The following icons indicate data services:
  - ![Network Connection](image)
    
    You are in a coverage area where data services are available, but it does not indicate whether you are connected to a data network. This icon appears in the Main view of the Phone application (near the top of the screen).

  - ![Wireless Mode](image)
    
    Wireless Mode is on but you are not connected to any data network.

  - ![Data Services](image)
    
    You are connected to a data network. When the arrows are gray, you are in standby mode and you can receive calls. When the arrows are green, a data session is active (for example, when you are browsing the web) and you cannot receive calls.

Wireless Mode seems to turn off by itself

If a system error and reset occurs, Treo automatically turns on Wireless Mode if it was on before the reset. However, if Treo can't determine whether Wireless Mode was on before the reset, it does not turn on automatically and you must manually turn on Wireless Mode (see page 13).

Treo won't connect to the Internet

Your Treo supports high speed (Mobile IP) data services. To connect to the Internet, you must subscribe to and activate data services with Verizon.

- Press and hold the Wireless Mode button to turn off Wireless Mode. Then, press and hold the same button to turn it back on again.
- Make sure the Data Services icon appears in the Main view of the Phone application (near the top of the screen). If you do not see this icon, data services are not available in your current location and you cannot connect to the Internet.
- Perform a soft reset (see page 141).
• For additional suggestions, see www.palmOne.com/support.
• Contact Verizon to verify that your subscription plan includes high-speed data services and that these services have been correctly activated. Verizon should also be able to tell you if there are any outages in your location. Confirm your user name and password.
• Confirm that high-speed data services are correctly configured on your Treo:
  1. Press Applications Launcher.
  2. Choose the pick list in the upper-right corner, then select All.
  3. Choose the Prefs icon.
  4. Choose the pick list in the upper-right corner, then select Network.
  5. If the Service field says Untitled, choose the Service pick list, then select the appropriate data service. Call Verizon for more information about their data services.
  6. Choose Connect.

I can’t send or receive text or multimedia messages
• Make sure Wireless Mode is turned on (see page 13).
• Make sure the Data Services icon appears in the Main view of the Phone application (near the top of the screen). If you do not see this icon, data services are not available in your current location and you cannot exchange multimedia messages. You can still exchange text messages without data services.
• Contact Verizon to verify that your plan includes messaging services, that these services have been correctly activated, and that they are available at your location. (Verizon should be able to tell you if messaging services have been experiencing transmission delays).
• If possible, contact the recipient or sender of the message, and make sure the receiving device can handle the type of file that is being sent.
• If a text message arrives but does not display an alert, perform a soft reset (see page 141).
Synchronization (HotSync)

Synchronization lets you back up your Treo data onto your computer. If you ever need to perform a hard reset or otherwise erase all your data on your Treo, you can perform a HotSync operation to restore the data. To make sure you always have an up-to-date backup of your data, synchronize frequently.

Before you attempt a HotSync operation, make sure that you installed Palm Desktop software and HotSync Manager from the CD that came with your Treo.

Desktop does not respond to HotSync attempt
Perform a HotSync operation after each of these steps. If the synchronization is successful, you do not need to complete the remaining steps.
1. Verify that the HotSync cable is securely connected at all points (see page 29).
2. Make sure that HotSync Manager is running:
   - Windows: Click the HotSync Manager icon in the lower-right corner and make sure Local USB is checked. If you don’t see the HotSync Manager icon, click Start, select Programs, select palmOne and then select HotSync Manager.
   - Macintosh: Find the Palm folder on your Mac hard drive. Double-click the HotSync Manager icon in the Palm folder. In the Connection Settings panel, set the Local Setup Port to palmOne USB.
3. Verify with your computer hardware vendor that your operating system supports your internal USB Controller.

Every device needs a unique name. Never synchronize more than one device to the same user name on your computer.

If you’re using an optional serial HotSync cable, click the HotSync Manager icon on your computer and make sure Local Serial is checked.
1. If you upgraded from a previous Palm Powered device, there may be conflicts with files from your previous device. Locate your Backup folder (Windows: C:\Program Files\Palm\user name or C:\Program Files\Handspring\user name; Macintosh: Mac HD\Applications\Palm\Users\user name or Mac HD\Applications\Handspring\Users\user name). Move the Backup folder to another location (such as your computer desktop). Perform a HotSync operation, and then manually reinstall any third-party applications you want on your new phone from the items in the old Backup folder you moved.

2. (Windows only) If the Windows New Hardware Wizard appears, the HotSync process may be timing out before the wizard completes its job. Follow all instructions in the New Hardware Wizard, and attempt another HotSync operation.

3. Uninstall Palm Desktop.
4. Reboot your computer.
5. Reinstall Palm Desktop.

4. Perform a soft reset (see page 141).
5. If problems persist and you’re synchronizing through a USB hub, try connecting the HotSync cable to a different USB port, or directly to your computer's built-in USB port.
6. Uninstall Palm Desktop.
7. Reboot your computer.
8. Reinstall Palm Desktop.

HotSync operation starts but stops without finishing
Perform a HotSync operation after each of these steps. If the synchronization is successful, you do not need to complete the remaining steps.

1. If you upgraded from a previous Palm Powered device, there may be conflicts with files from your previous device. Locate your Backup folder (Windows: C:\Program Files\Palm\user name or C:\Program Files\Handspring\user name; Macintosh: Mac HD\Applications\Palm\Users\user name or Mac HD\Applications\Handspring\Users\user name). Move the Backup folder to another location (such as your computer desktop). Perform a HotSync operation, and then manually reinstall any third-party applications you want on your new phone from the items in the old Backup folder you moved.

2. (Windows only) If the Windows New Hardware Wizard appears, the HotSync process may be timing out before the wizard completes its job. Follow all instructions in the New Hardware Wizard, and attempt another HotSync operation.

3. Uninstall Palm Desktop.
4. Reboot your computer.
5. Reinstall Palm Desktop.
HotSync operation finishes but data does not appear where it should

1. Make sure you're synchronizing with the intended desktop Personal Information Manager (PIM). The CD that came with your Treo lets you synchronize with Palm Desktop or Microsoft Outlook for Windows. If you use a different PIM, you will need to install third-party software to synchronize. Consult the company that makes the PIM for more information.

2. If there are multiple Palm Powered devices synchronizing with your computer, make sure you are synchronizing with the correct user name. If data is not appearing in Palm Desktop, make sure the correct user name is selected in the toolbar of Palm Desktop.

3. Launch the HotSync Manager application on your computer, and make sure the necessary conduits are set to Synchronize the files.

4. Uninstall Palm Desktop.

5. Reboot your computer.

6. Reinstall Palm Desktop.

7. (Outlook only) With the included software, your Treo can synchronize with the root folders of Contacts, Calendar, Tasks, and Notes. If you want to synchronize with a global Exchange Address Book, you must copy the addresses to your local Contacts list in Outlook (right-click the addresses, and select Add to Personal Address Book).

8. (Outlook only) Outlook subfolders and public folders are not accessible with the included software. You may wish to use a third-party solution instead.

9. (Outlook only) If you're trying to synchronize offline, be sure to set your Outlook Calendar, Contacts, Notes, and Tasks to be available offline.
Web

I can’t access a page

- Make sure Wireless Mode is turned on (see page 13) and that the Data Services icon appears in the Main view of the Phone application (near the top of the screen). If you do not see this icon, data services are not available in your current location and you cannot connect to the Internet.
- Try to view a web page you’ve loaded before. From Blazer®, press Menu, then from the Page menu, choose Refresh to get the latest version from the Internet. After confirming your Internet connection, try to view the page again, and press Menu, then from the Page menu, choose Refresh.
- If you still have trouble, the page may contain elements that are not supported by Blazer. These include Flash, Shockwave, VBScript, WML script, and other plugins.
- Some web sites use a redirector to the true page (for example, the address http://www.palmOne.com/support may resolve to http://www.palmOne.com/us/support). If Blazer can’t follow the redirect, use a browser on your computer to see where the redirect sends you, and enter that address in Blazer.

An image or map appears too small on the Treo screen

Blazer has two modes: Optimized and Wide Page. Optimized Mode resizes all images and page elements to fit in a single column on the Treo screen. Switch to Wide Page mode to see the full-size image (see page 56).

A secure site refuses to permit a transaction

Some web sites don’t support certain browsers for transactions. Please contact the site’s webmaster to make sure the site allows transactions using Blazer.
Pictures

If your Treo 600 does not include a camera, then the information in this section about taking pictures does not apply to you. Here are some tips for taking good pictures if your model includes a camera:

- Clean the camera's lens with a soft, lint-free cloth.
- Take pictures in bright lighting conditions. Low-light images may be grainy due to the sensitivity of the camera.
- Hold the camera as still as possible. You may want to support your picture-taking arm against your body or a stationary object (such as a wall).
- Keep the subject of the pictures still. Exposure time is longer with lower light levels, so you may see a blur.
- For best results, verify that you have the brightest light source coming from behind you, lighting the subject's face. Don't take indoor pictures with the subject in front of a window or light.
- Make sure the subject is at least 18 inches away from the camera to ensure good focus.

Remember, when you synchronize, your Pictures images are stored in the Treo Pictures folder on your hard drive (see page 67).

The camera’s preview image looks strange
Some third-party applications overwrite the Treo’s color settings with their own 8-bit color settings. This can affect the camera’s preview mode. Delete third-party applications one-by-one until the preview image improves.

When using the camera in low light, you may see blue specks on the screen. Once you capture the image, the quality improves, and many of the blue specks disappear.

The built-in camera takes pictures at Small picture size (160x120 pixels) and Large picture size (640x480 pixels, or 3 megapixel).
Third-party applications

Sometimes, third-party applications can cause conflicts on your Treo. Third-party applications that modify wireless features may require extra troubleshooting.

If you recently installed an application and your Treo seems to be stuck, try the following:
1. Perform a soft reset (see page 141).
2. If the problem persists, perform a system reset (see page 141).
3. Delete the most recently installed application from your Treo (see page 109).
4. If the problem persists, perform another system reset.
5. Delete other third-party applications one at a time until you eliminate the problem.
6. If none of the steps above are possible, you may wish to perform a hard reset (see page 142). Then, locate your Backup folder on your computer (Windows: C:\Program Files\palmOne\user name; Macintosh: Mac
   HD\Applications\palmOne\Users\user name). If you find a .prc or .pdb file for any applications you just removed, delete the file(s) from the Backup folder. Then, perform a HotSync operation to restore your data and applications.

Remember, not all third-party applications are optimized for the Treo keyboard and 5-way navigation control. You may encounter strange behavior or errors in these applications if you use the keyboard and navigation control.

Getting more help
Contact the author or vendor of any third-party software if you require further assistance.
Making room on your Treo

If you store a large number of records, or install many third-party applications, the internal memory on your Treo may fill up. Here are some common ways to clear space on your Treo:

- **Pictures:** Large size images take up a lot of memory. Move images to an expansion card or delete images from your Treo (see page 67).
- **MMS:** Multimedia content also can consume excessive memory. Remove old multimedia messages by deleting individual messages or by purging a group of messages from your Treo (see page 78).
- **Internet:** If you have set a large Blazer cache, you can use Blazer's advanced Memory Management settings to clear all recent pages (see page 61).
- **Third-party applications:** You can delete infrequently used applications or move them to an expansion card (see page 113).

Also, remember that your Treo includes an expansion slot, and that you can store applications and data on expansion cards. However, you still need some free memory on the Treo itself to run applications from an expansion card.
Voice quality

Is the other person hearing an echo?
- Try decreasing the Treo's volume to avoid coupling or feedback on the other person's end. This applies to both speakerphone and the built-in handset speaker.
- Position the Treo handset closer to your ear to prevent sound leaking back to the microphone. Keep your hand away from the microphone hole, which is on the back of your Treo near the bottom of the device.
- If you're using Speakerphone mode with the device lying on a flat surface, try turning the Treo "face down" (screen facing the surface).

Are you hearing your own voice echo?
- Ask the other person to turn down their volume or hold the phone closer to their ear.

Is your voice too quiet on the other end?
- Be sure to hold the bottom of the Treo, or the hands-free microphone, close to your mouth.
Glossary

Alt (alternative): A keyboard key. Type a letter on the keyboard, then press Alt to access variations such as international characters and symbols.

Applications Launcher: The view on your Treo™ 600 smartphone from which you can launch all applications.

Auto-off interval: The time of inactivity that passes before the screen on your Treo turns off. Wireless Mode is unaffected by this setting.

Beam: The process of sending or receiving a data record or application using the infrared port on your Treo.

HotSync®: The PalmSource technology that synchronizes your Treo and your computer with the simple press of a button.

HotSync Manager: The computer application that manages the synchronization with your Treo.

Infrared (IR): A way of transmitting data using light waves. The IR port on your Treo lets you transfer data between other IR devices within a short radius.

Install tool: The component of Palm® Desktop software that enables you to install Palm OS® applications and data on your Treo.

Lithium Ion (Li-Ion): The rechargeable battery technology used in Treo phones.

Lock Code: The four-digit password assigned to your phone by Verizon. Turning on the Lock Code secures your wireless account.

MMS (Multimedia Messaging System): An enhanced form of SMS messaging that lets you send pictures, animations, and ringtones almost instantly.

Mobile IP: High speed mobile data technology that enables rapid access to network data services including Internet connectivity.

Option key: The keyboard button that lets you access the alternative feature that appears above the letter on each key.

Palm Desktop: A PIM application for computers that helps you manage your personal information and keep your personal data synchronized with your Treo.
Palm OS: The operating system of your Treo phone. A trademark of PalmSource, Palm OS is known for its simplicity of use and for the large number of applications that can be added to your Treo.

Phone: The application on your Treo that provides quick access to the most commonly used applications on your Treo.

PIM (Personal Information Management): A category of software that includes applications such as Palm Desktop software, Microsoft Outlook, Lotus Notes, and ACT! PIMs generally store contacts, schedules, to do items, and memos.

Pix Place: A service for managing pictures on the Internet.

PocketMirror: Software included on the Treo CD that lets you synchronize with Microsoft Outlook (English language and Windows only). PocketMirror is made by a third-party company called Chapura, Inc.

SMS (Short Messaging Service): The service that exchanges short text messages almost instantly between mobile phones. These messages can usually include up to 160 characters. Treo phones can send and receive text messages while you are on a voice call.

User name: The name associated with your Treo that distinguishes it from other Palm Powered™ devices. When you first synchronize your Treo, you are asked to give it a user name.

Wireless Mode: The feature inside your Treo that controls the radio which enables you to connect to the mobile network for wireless communications.
This device complies with part 15 of the FCC rules.
Operation is subject to the following two conditions: (1) This device may
not cause harmful interference, and (2) this device must accept any
interference received, including interference that may cause undesired
operation.

This device has been tested and found to comply with the limits for a
Class B digital device, pursuant to part 15 of the FCC Rules. These limits
are designed to provide reasonable protection against harmful
interference in a residential installation. This equipment generates, uses,
and can radiate radio frequency energy and, if not installed and used in
accordance with the instructions, may cause harmful interference to radio
communications. However, there is no guarantee that interference will not
occur in a particular installation. If this equipment does cause harmful
interference to radio or television reception, which can be determined by
turning the equipment off and on, the user is encouraged to try to correct
the interference by one or more of the following measures:
• Reorient or relocate the receiving antenna
• Increase the separation between the equipment and receiver
• Connect the equipment into an outlet or circuit different from that to
which the receiver is connected
Consult the dealer or an experienced radio/TV technician for help and
for additional suggestions.
RF Safety Exposure To Radio Frequency Energy (SAR)
Radio transmitting devices radiate Radio Frequency (RF) energy during its
operation. RF energy can be absorbed into the human body and
potentially cause adverse health effects if excessive levels are
absorbed. The unit of measurement for human exposure to RF energy is
“Specific Absorption Rate” (SAR).
The Federal Communications Commission (FCC), Industrie Canada
(IC), and other agencies around the world have established limits that
incorporate a substantial safety margin designed to assure the safety of all
persons using this equipment.
In order to certify this unit for sale in the US, Canada and Europe this
unit has been tested for RF exposure compliance at a qualified test
laboratory and found to comply with the regulations regarding exposure to
RF Energy.
SAR was measured with the unit transmitting at its maximum certified
RF power. Often, however, during normal operation the unit will transmit
much less than maximum power. Transmit power is controlled
automatically and, in general is reduced as you get closer to a cellular base
station. This reduction in transmit power will result in a lower RF energy
exposure and resulting SAR value.

FCC RF Safety Statement
In order to comply with FCC RF exposure safety guidelines, users MUST use one of the following types of body-
worn accessories.
1. A palmOne brand body-worn accessory that has been tested for SAR
compliance and is intended for use with this product.
2. An accessory that contains NO metal (snaps, clips, etc) and provides AT
LEAST 1 cm of separation between the users body and the unit.
Do NOT use the device in a manner such that it is in direct contact with
the body (i.e. on the lap or in a breast pocket). Such use will likely
exceed FCC RF safety exposure limits See www.fcc.gov/oet/rfsafety/ for more information on RF exposure safety.

Responsible party
(North America) (Europe)
palmOne, Inc. Vesey Chrichton
400 N. McCarthy Blvd. Buckhurst Court
Milpitas, CA 95035 London Road
USA Wokingham, Berkshire RG40 1PA,
www.palmone.com UK

Declaration of Conformity
Treo Model 600 palmOne declares that the above models of Treo
smartphones are compliant with the regulations below. The declaration
applies to the communicators and their associated accessories (power
supply, headset, USB and serial cable) where applicable.

Maximum Measured SAR Values (W/kg)

<table>
<thead>
<tr>
<th>Frequency</th>
<th>Head SAR</th>
<th>Body SAR</th>
</tr>
</thead>
<tbody>
<tr>
<td>850 MHz</td>
<td>1.49</td>
<td>.646</td>
</tr>
<tr>
<td>900 MHz</td>
<td>1.07</td>
<td>.703</td>
</tr>
<tr>
<td>1800 MHz</td>
<td>1.53</td>
<td>.402</td>
</tr>
<tr>
<td>1900 MHz</td>
<td>1.05</td>
<td>.336</td>
</tr>
</tbody>
</table>

EMC: EN 301 489
EN 300 220 (Dec 1999)
EN 50360 (Jul 2001)
FCC OET Bulletin 65 Supplement C
Radiated Emissions: EN 55022
GSM: EN 301 410 (Apr 2000)
SAR: ANSI/IEEE C95.1 1992
EN 50361 (Jul 2001)
Safety: EN 60950: 2001 (Jan 2000)
Immunity: EN 55024
Antenna Care/Unauthorized Modifications

Use only the supplied integral antenna. Unauthorized antenna modifications or attachments could damage the unit and may violate FCC regulations. Any changes or modifications not expressly approved by the party responsible for compliance could void the user's authority to operate the equipment.

Operational Warnings

IMPORTANT INFORMA LON ON SAFE AND EFFICIENT OPERATION. Read this information before using your integrated multi-service portable radio.

For the safe and efficient operation of your radio, observe these guidelines:

Potentially Unsafe Areas / Potentially explosive atmospheres Obey all signs and instructions regarding turning off your phone. In particular, turn off your phone when you are in any areas with a potentially explosive atmosphere, such as fueling areas (gas or petrol stations, below deck on boats), storage facilities for fuel or chemicals, blasting areas and areas near electrical blasting caps, and areas where there are chemicals or particles (such as metal powders, grains, and dust) in the air.

Interruption to Medical and Personal Electronic Devices Most but not all electronic equipment is shielded from RF signals and certain electronic equipment may not be shielded against the RF signals from your Treo.

Pacemakers The Health Industry Manufacturers Association recommends that a minimum separation of six inches (6") be maintained between a handheld wireless phone and a pacemaker to avoid potential interference with the pacemaker. These recommendations are consistent with the independent research by the recommendations of Wireless Technology Research.

Persons with pacemakers should:

• ALWAYS keep the phone more than six inches from their pacemaker when the phone is turned ON.
• Not carry the phone in a breast pocket.
• Use the ear opposite the pacemaker to minimize the potential for interference.
• Turn the phone OFF immediately if you have any reason to suspect that interference is taking place.

Audio Safety Some hearing aids may be affected by some digital wireless phones. You may want to consult your doctor in the event of you experience interference with your hearing aid while using Treo. When using the speakerphone feature, it is recommended that you place Treo at a safe distance from your ear.

Interference to Other Electronic Devices RF energy may affect improperly installed or inadequately shielded electronic operating and entertainment systems in motor vehicles. Check with the manufacturer or representative to determine if these systems are adequately shielded from external RF energy. Also check with the manufacturer of any equipment that has been added to the vehicle.

Repetitive Motion Injuries When using the keyboard or playing games on your phone, you may experience discomfort in your neck, shoulders, hands, arms, of other parts of the body. To avoid any injury, such as tendinitis, carpal tunnel syndrome, or other musculoskeletal disorder, make sure to take necessary breaks from use, take longer rests (such as several hours) if discomfort or tiring begins, and see a doctor if discomfort persists.

Using TTY

A TTY (also known as TDD or Text Telephone) is a telecommunications device that allows people who are deaf or hard of hearing, or who have speech or language disabilities, to communicate by telephone.

Your Treo 600 is compatible with select TTY devices. You can connect a TTY/TDD machine to your phone through the headset jack, but you cannot use your headset jack with a headset or hands-free kit while this mode is enabled. Please check with the manufacturer of your TTY device for connectivity information and to ensure that the TTY device supports digital wireless transmission.

To use TTY, you may need to make additional arrangements with Verizon. Please contact their customer service department for more information.

1. Press Phone.
2. Press Menu.
3. From the Options menu, choose Phone Preferences (/A).
4. Choose the TTY Mode pick list, then select the appropriate mode.
5. Choose OK. A red “T” appears at the top of the Phone screen whenever TTY is enabled.
Blackouts and Seizures Blinking lights, such as those experienced with television or playing video games, may cause some people to experience blackouts or seizures, even if never experienced before. In the event a Treo user should experience any disorientation, loss of awareness, convulsion, eye or muscle twitching or other involuntary movements, stop use immediately and consult a doctor. Individuals with personal or family history of such events should consult a doctor before using the device. To limit the possibility of such symptoms, wherever possible every hour take a minimum of 15 minutes, use in a well lighted area, view the screen from the farthest distance and avoid exposure to blinking lights if you are tired.

Aircraft While in aircraft, follow all instructions regarding the operation of your Treo. Use of your Treo while on board on aircraft must be done in accordance in compliance with airline instructions and regulations.

Vehicles with Air Bags Your Treo should not be placed in a position that would affect the operation of air bag deployment or in a position that, should the air bag inflate, could propel the Treo. Air bags will inflate with great force and care should be taken to protect within a vehicle that has air bags.

Battery Your Treo includes an internal lithium ion battery. Please note that use of certain data applications can result in heavy battery use and may require frequent battery charging. Any disposal of the phone must comply with laws and regulations pertaining to lithium ion batteries.

Driving Safety Tips Overview Always obey all laws and regulations on the use of phones in your driving area.

Safety Your most important call. The Wireless Industry reminds you to use your phone safely when driving.
1. Get to know your phone and its features, such as speed dial and redial.
2. When available, use a hands-free device.
3. Position your phone within easy reach. Make sure you place your wireless phone within easy reach and where you can grab it without removing your eyes from the road. If you get an incoming call at an inconvenient time, let your voice mail answer it for you.
4. Dial sensibly and assess the traffic; if possible, place calls when you are not moving or before pulling into traffic. Try to plan your calls before you begin your trip, or attempt to coincide your calls with times you may be stopped at a stop sign, red light or otherwise stationary. But if you need to dial while driving, follow this simple tip: dial only a few numbers, check the road and your mirrors, then continue.
5. Do not take notes or look up phone numbers while driving. If you are bringing a "to do" list, then you are not watching where you are going. It's common sense. Don't get caught in a dangerous situation because you are reading or writing and not paying attention to the road or nearby vehicles.
6. Dial sensibly and assess the traffic; if possible, place calls when you are not moving or before pulling into traffic. Try to plan your calls before you begin your trip, or attempt to coincide your calls with times you may be stopped at a stop sign, red light or otherwise stationary. But if you need to dial while driving, follow this simple tip: dial only a few numbers, check the road and your mirrors, then continue.
7. Do not engage in stressful or emotional conversations that may divert your attention from the road.
8. Dial 9-1-1 to report serious emergencies - it's free from your wireless phone!
9. Use your phone to help others in emergencies. 10.CaI roadside assistance or a special non-emergency wireless number when necessary.
9. Use your phone to help others in emergencies. Your wireless phone provides you a perfect opportunity to be a "good Samaritan" in your community. If you see an auto accident, crime in progress, or other serious emergency where lives are in danger, call 9-1-1, as you would want others to do for you.

10. Call roadside assistance or a special wireless non-emergency assistance number when necessary. Certain situations you encounter while driving may require attention, but are not urgent enough to merit a call to 9-1-1. But you can still use your wireless phone to lend a hand. If you see a broken-down vehicle posing no serious hazard, a broken traffic signal, a minor traffic accident where no one appears injured, or a vehicle you know to be stolen, call roadside assistance or other special non-emergency wireless number.

NOTICE FOR CONSUMERS WITH HEARING DISABILITIES

Digital Wireless Phones to be Compatible with Hearing Aids

On July 10, 2003, the Federal Communications Commission (FCC) modified the exemption for wireless phones under the Hearing Aid Compatibility Act of 1988. This means that wireless phone manufacturers and service providers must make digital wireless phones accessible to individuals who use hearing aids.

For more information, please go to the FCC’s Consumer Alert on accessibility of digital wireless phones at http://www.fcc.gov/cgb/consumerfacts/accessiblewireless.html.

Wireless telephones are hand-held phones with built-in antennas, often called cell, mobile, or PCS phones. These phones are popular with callers because they can be carried easily from place to place.

Wireless telephones are two-way radios. When you talk into a wireless telephone, it picks up your voice and converts the sound to radio frequency energy (or radio waves). The radio waves travel through the air until they reach a receiver at a nearby base station. The base station then sends your call through the telephone network until it reaches the person you are calling.

When you receive a call on your wireless telephone, the message travels through the telephone network until it reaches a base station close to your wireless phone. Then the base station sends out radio waves that are detected by a receiver in your telephone, where the signals are changed back into the sound of a voice.

The Federal Communications Commission (FCC) and the Food and Drug Administration (FDA) each regulate wireless telephones. FCC ensures that all wireless phones sold in the United States follow safety guidelines that limit radio frequency (RF) energy. FDA monitors the health effects of wireless phones. Each agency has the authority to take action if a wireless phone produces hazardous levels of RF energy.


FCC derives its authority to regulate wireless telephones from the National Environmental Policy Act of 1969 (NEPA) and the Telecommunications Act of 1996 [http://www.fcc.gov/telecom.html].

Updated 7/16/2003

Hands-Free Capability

All CTIA Certified portable products provide the consumer with a toll-free number for the purchase of a compatible hands-free device.

1-800-881-7256

FCC 161
Index

Numerics
1X icon 55, 64, 74, 145, 146, 150
24-hour clock 127
5-way navigation control. See under five

A
AC charger 11
accented characters 24, 25
accessing
applications 26, 27
common tasks 51
Dial Pad 44
web pages 55, 56
activating
application menus 21
keyboard backlight 23
on-screen buttons 20
speakerphone 44
web links 56
active call 37, 44
Active Call view 44, 129
adding
alarms to events 83
bookmarks 56
Caller ID pictures 52, 118
cities to world clock 94
contacts 49
events 82, 84
expansion cards 111, 112
memos 92
multimedia messages 74
passwords 42, 134
personal information 133
QuickText phrases 68
speed dial buttons 52
text messages 68
To Do items 88
additional information and resources 34, 152
Address Book. See Contacts View
Address Book Lookup option 75
adjusting
brightness 121
call volume 15, 41, 117
screen contrast 14, 121
system sounds 128
Advanced Calculator mode 95, 96
alarms 83, 117
alert tones 116
alerts
See also alarms
adjusting volume for 128
displaying information with 78
incoming messages 43, 69, 76
selecting tones for 116
turning off 120
viewing pending 83
aligning the touchscreen 122
alternate characters 24, 25
annual events 84
answering phone calls 41
antenna 8
application buttons and icons 26, 123
applications
See also specific application
accessing 26, 27
active calls and 45
associating with buttons 53, 124
beaming 102
categorizing 123
copying 113
downloading 106
installing 106, 107, 108, 124
launching 26, 112, 124
removing 109, 151, 153
setting default 125
troubleshooting third-party applications 108, 152
viewing statistics about 110
Applications Launcher 27, 112, 123
appointments. See events
Archive folder 109
area conversions 96
assistance 34
audio files 41
Auto Lock Handheld setting 132
Auto-Keyguard setting 130
Auto-off setting 33, 128

B
backing up data 28, 139, 147
backlight 11, 13, 23, 121
Basic Calculator mode 95
basics 4, 6, 34
battery
charging 11, 32
consumption factors for 11
maximizing life of 13, 32, 121
resetting handset and 141
viewing status of 12, 37
battery gauge 12
Beam Business Card command 50
Beam Category command 101
Beam command 101, 102
Beam Status dialog box 101, 102
beaming
applications 102
information 101, 103, 128
beeps 128
blank screens 143
blank time slots 86
Blazer Web Browser 55–62, 106, 153
blue dots 63
Bookmark view 58
bookmarks 56, 58
brightness 121
browsing. See web browsing
buddy lists 49
built-in applications 106, 109
business cards 50, 101
business software 106
buttons
associating with applications 53, 124
disabling 130
highlighted 19
navigation control 18
restoring defaults for 124
selecting 19, 20
setting preferences for 124
C
calculators 95–97
calendar 82–87
Calendar button 9, 82
calendar views 86
Call Log view 40, 47
call waiting 46
Caller ID pictures 52, 118
calls. See phone calls
camera 66, 151, 153
camera lens 10
canceling selections 22
Caps Lock 24
Card Info application 114
categorizing
applications 123
memos 92
Change Location command 94
carring
bookmarks 58
contact information 50
due dates 90
Favorites buttons 53
lock codes 131
passwords 130
QuickText phrases 68
screen fonts 122
text entries 19
character sets 24, 25
character strings 99
change indicators 9, 37
charger cable 11
charging the battery 11, 32
chat sessions 70, 71, 72
checking voicemail messages 37, 70
clock 93–94, 126
closing application menus 21
color preferences  system 122, 128
text messages 73
command buttons 20
company searches 99
composing. See creating; entering
compressed files 106
computers
connecting handset to 29
setting up 28–30
conduit software 31
conference calling 46
connections 13, 29, 42, 144
conserving battery power 13, 32, 121
contact name, dialing by 38, 47
contacts
adding 49
changing information for 50
locating 98
marking as private 49
removing 50
Contacts View 49
customizing
Blazer Web Browser 61
calendar 85
camera settings 66
MMS messaging 78
phone 116
Pictures settings 66
SMS messaging 72
system colors 122
To Do Lists 87, 90

damaged expansion cards 111
copyrighted pictures 64
coverage areas 14, 144
creating
bookmarks 56
business cards 50
Caller ID pictures 52, 118
cities for world clock 94
contacts 49
events 82, 84
memos 92
multimedia messages 74
passwords 42, 134
QuickText phrases 68
speed dial buttons 52
text messages 68
To Do Lists 88
customer assistance 34
deleting
applications 109, 151, 153
data
See also information
backing up 28, 139, 147
expansion cards and 111
keeping private 129
losing 138, 147
restoring 147
storing on handset 32, 111
synchronizing 28, 31, 147–149
transferring 37, 101
data entry 24
data services 6, 55, 145
data services icon 55, 64, 74, 145, 146, 150
dates
See also calendar
assigning to events 82, 84
setting for alarms 83
setting for To Do items 87, 89, 90
setting system 126
specifying formats for 127
datestamps 72
Day view 82
daylight savings 126
decimal values (calculator) 97
decompression utility 106
definitions 156
delays 132
deleting
applications 109, 151, 153
Index :: 165
bookmarks 58  
contacts 50  
events 84  
Favorites button 53  
memos 92  
multimedia messages 78  
passwords 130  
pictures 65, 66  
text messages 71, 72  
To Do items 88, 90  
Dial Extra Digits option 52  
Dial Pad 39, 40, 44, 118  
dialing 14, 38–40, 44, 47  
See also phone calls  
dialing service 47  

disabling  
handset 130  
incoming calls 41  
disclaimer 2  
discussion groups 34  
displaying  
application information 110  
bookmarks 58  
calendar 82, 85, 86  
events 86  
expansion card information 114  
images 55, 61  
multimedia messages 75, 76, 77  
pictures 64, 67  
private records 135  
recently dialed numbers 40  
text messages 69  
To Do List items 87, 88, 90  
web pages 55, 58  
documentation 7, 18  
Don't Show Images check box 55  
downloading  
applications 106  
files 59  
images 59  
messages 76, 78  
Palm Desktop software 2  
downsizing pictures 64  
drawings. See images; pictures  

echoes 154  
Edit Bookmarks command 58  
Edit Cities command 94  
Edit Favorites Button command 53  
Edit Favorites Pages command 53  
Edit Name command 65  
editing. See changing  
email  
See also text messages  
active calls and 45  
requirements for 6  
sending 70, 150  
email applications 70, 150  
emergency calls 47, 129, 131  
emotive symbols 68  
empty battery icon 12  
engineering notation 97  
entering  
information 24  
multiple contacts 49  
numbers in calculator 95  
passwords 43, 52  
personal information 133  
phone numbers 38, 39, 40  
text messages 68  
error messages 108  
events  
creating 82–85  
displaying 86  
setting preferences for 85, 86  
exansion cards  
adding 111, 112  
beaming to 101  
copying to 65, 113  
formatting 114  
removing applications from 109  
running applications from 112, 153  
viewing information about 114  
expansion slot 8, 111  
Extra Digits setting 44, 52  

F  
Favorites buttons 39, 51–53, 118  
features (Treo handset) 8
Index :: 167

feedback 154
files
  decompressing 106
downloading 59
financial calculator 95, 96
Find dialog box 99
Find More button 99
finding
  information 98
  owner phone number 15
text 61, 99
5-way control buttons 18
5-way navigation control
  adding contacts with 49
  answering calls from 41
  choosing items with 20, 22
dialing with 38
  displaying calendar with 82
  highlighting items from 19
  location of 9
  scrolling with 18
fixed point notation 97
floating events 86
fonts 122
forgetting passwords 136
Format Preferences settings 127
formatting expansion cards 114
freeing memory 88, 109, 153
full battery icon 12
functions (calculator) 95, 96
G
games 32, 106, 128
General Preferences settings 128
getting started 4, 6, 34
GIF files 74
Glossary 156
graphics. See images
green lightning bolt 12
H
handset. See Treo handset
Hang Up All button 44
hard resets 131, 142, 147
header information (messages) 77
headsets 9, 54
help 34, 152
hexadecimal characters 96
hiding images in web pages 55
hiding private records 134
highlighting 19–20, 21
hints 34
History list 60
Hold button 44
Home City setting 93
Home Page option 61
HotSync button 124
HotSync cable 28, 29, 147
HotSync connector 9
HotSync Manager 31, 147
HotSync operations 31, 147–149
I
image files 67, 74
images
  See also pictures
  assigning to Caller ID 52, 118
  displaying in web pages 55,
  61
downloading 59
  resizing 64
  storing 153
troubleshooting 150, 151
iMelody files 74
importing phone numbers 89
Inbox 70, 76
incoming messages 70
Info screens 110
information
  backing up 28, 139, 147
  beaming 101, 128
  entering 24
  finding 98
  in reverse type 19
  receiving 103
  recording personal 133
  synchronizing 31, 147–149
  transferring to handset 28, 37
  updating 31
  viewing application 110
Information icon 34
Infrared port. See IR port
installing applications 106, 107, 108, 124
Palm OS software 106, 140
synchronization software 28, 30
international characters 25
Internet connections 13, 106
invalid characters 68
IR port
beaming from 101, 102, 103
location of 8

JPEG files 67, 74

keyboard
dialing with 38
locking 130
overview 23–24
keyboard backlight 11, 13, 23, 121
Keyboard Help command 24
keyboard shortcuts 21
keyguard feature 14, 130

launching applications 26, 112, 124
LED indicator 9, 11, 32
length conversions 96
lens (camera) 10
liability 2
listening to music 54
lists
cancelling selections in 22
choosing items in 20
highlighting items on 19
moving through 18
selecting options in 22
loading web pages 55, 61
locating
information 98
owner phone number 15
text 61, 99
Location icon 48
lock codes 131
lock icon 55, 102, 109
Lock Wireless Mode options 131
locked messages 70
locking the handset 129, 131, 132
logic functions (calculator) 96
losing data 138, 147
low coverage areas 144
lowercase letters 24

Macintosh information
installing applications 108
installing synchronization software 28
removing applications 109
synchronizing data 147
magnet 10
manually activating backlight 13
manually setting clock 126
maps 150
masking private records 134
mathematical constants 96
mathematical functions 96
maximizing battery life 13, 32, 121
media players 32
Memo Pad 92
memory 88, 109, 112, 153
memory slots (calculator) 96
memos 92
See also messages; notes
Menu button 21
menus 21
messages
See also text messages
checking voicemail 37
creating multimedia 74, 75
receiving multimedia 76, 78
retrieving voicemail 37, 43
reverse type in 19
sending to voicemail 41
setting alerts for 117
viewing header information 77
messaging services 6
metric conversions 96
microphone 9, 44, 54, 154
Microsoft Outlook. See Outlook
Microsoft Windows See Windows information
MIDI files 74
MMC cards 111
MMS icon 74
MMS messaging 6, 74, 78
See also multimedia messages
mobile accounts 34
mobile networks 13
mobile phone. See Treo handset
monthly events 84
moving through menu items 21
web pages 56, 60
MultiMedia cards 111
multimedia messages
See also MMS messaging
addressing 75
creating 74, 75
paging through 75, 77
playing 77
previewing 75
receiving 74, 76, 78
responding to 77
saving 74
sending 74, 75
setting preferences for 78
sorting 78
storing 153
troubleshooting 146
multi-page messages 75

multiple recipients 68, 75
music 41, 54
Mute button 44

N
Name Lookup feature 38, 98
navigation buttons 18
navigation control. See 5-way navigation control
network status icon 14
networks 13, 144
New Contact button 49
New Text Message screen 69
nighttime use 13
No Service message 14
Note Pad. See Memo Pad
notes 49, 68, 89
See also memos; messages notifications 43, 69, 76, 78
numbers 24, 95, 97

O
offline viewing (web pages) 57
online forums 34
online support 34
opening
Blazer Web Browser 55
Dial Pad 44
Find dialog box 99
Phone application 36
Optimized Mode (web pages) 56
optimizing performance 29, 32
Option Lock 24
options 22, 86
See also preferences
organizer features 32, 81
Outbox 70
outgoing messages 70
Outlook 28, 82, 140, 149
owner preferences 133

P
Page View icon 55
paging through web pages 55
paging tool 18
Palm Desktop software 2, 28
Palm OS features 13, 27, 106, 140
Palm Powered devices 149
partial battery icon 12
passwords changing 130
creating 42, 134
entering 43, 52
forgetting 136
specifying as required 132
PCs. See computers
pending alerts 83
pending messages 71
performance 29, 32
personal computers. See computers
Personal Information Managers (PIMs) 140, 149
phone (disabled) 11
Phone application
accessing 36
creating business cards with 50
managing calls from 44, 45
managing contacts from 49
monitoring information for 37
Phone button 9, 36
Phone calls
adjusting volume for 15, 117
battery consumption and 11
defining ringtones for 52, 116
disabling incoming 41
displaying most recent 40
losing 41
making duplicate 45
options for dialing 38, 44, 47
placing on hold 44, 45, 46
prerequisites for 14
privacy settings for 47
receiving 41
sending to voicemail 41
setting preferences for 116
setting up emergency 131
transmitting location during 47
turning off ringer for 120
viewing minutes usage for 47
phone headsets 54
Phone Info option 15
Phone Lock command 131
phone numbers
adding speed dial buttons for 52
adding to To Do List 89
dialing extensions for 44, 52
dialing from text messages 40, 70
entering 38, 39, 40
getting 15
labeling mobile 49
pasting to Dial Pad 39
redialing 40
specifying emergency 131
phone receiver 9
phone settings 116
photographs. See pictures; images
pick lists 19, 22
Pictures 63, 66
pictures 153
See also images
adding Caller ID 52, 118
downsizing 64
managing 65
multimedia messages and 74, 75
saving 63, 66
sending 64
setting size 66
taking with camera 63
viewing 64, 67
Pix Place accounts 64
pictures view icon 64
Pix Place accounts 64
phone numbers
playing
multimedia messages 77
music 54
PocketMirror software 149
power status 12
power supply connector 9
preferences
Blazer Web Browser 61–62
calendar 85
camera 66
multimedia messages 78
owner 133
phone calls 116
pictures 66
SMS messaging 72
system colors 122
To Do List 87, 90
preset delays 132
previewing multimedia messages 75
priority settings 70, 87, 89, 91
privacy settings 69, 89, 134
private records 134–135, 136
programmable buttons 51
protecting data 129
punctuation characters 24, 25
Purge command 71, 78, 88
Q
Quick Keys 51, 53
QuickText phrases 68
Index :: 171

R
receiving
information 103
multimedia messages 74, 76, 78
phone calls 41
text messages 69
recharging handset 32, 37
recording voice messages 42, 75
recurring events 84
red lightning bolt 12
redialing 40
refreshing web pages 55
Reminder screen 83
reminders 69, 83
See also alerts
remote cities 94
removing
applications 109, 151, 153
bookmarks 58
contacts 50
events 84
Favorites button 53
memos 92
multimedia messages 78
passwords 130
pictures 65, 66
text messages 71, 72
To Do items 88, 90
renaming
expansion cards 114
pictures 65
repeating events 84
replying to multimedia messages 77
rescheduling events 84
Reset button 10
reset tool 10, 141
resets 131, 141-142, 147
resizing images 64
restoring
data 147
factory defaults 124
private records 136
reverse type 19, 20
ringer 8, 41, 116, 120
Ringtone option 52
ringtones
multimedia messages 74, 75
phone calls 52, 116
selecting for caller ID 118
text messages 69
turning off 120
roaming 37

S
Save as Template command 74
saving
multimedia messages 74
pictures 63, 66
web pages 57
scheduling events 82, 84
scientific calculator 95
scientific notation 97
screen
adjusting contrast 14, 121
aligning 122
auto shutoff setting for 128
blue dots on 63
disabling 44, 128, 130
highlighting items on 19-20
moving around in 18
tapping Information icon on 34
troubleshooting 143
turning on and off 13, 33
Screen button 9
screen fonts 122
scroll arrows 19
scroll bars 19
scrolling 18
SD cards 65, 111
See also expansion cards
searching
information 98-100, 134
web pages 61
Secure Digital cards. See SD cards
secure web pages 55, 150
security software 129, 136
Select Business Card command 50
Select Home City command 93
sending
email 70, 150
multimedia messages 74, 75
text messages 68, 70, 71
Sent folders 70
serial cables 28
short messaging. See SMS messaging; text messages
shortcuts 21, 51, 139
Show Due Dates option 90
signal strength 11, 37, 144
signals 33
silencing the ringer 41, 116, 120
silent alarms 83, 120
sit files 106
SMS button 9
SMS messaging 53, 68, 71, 72
Snooze option 69, 76
soft resets 141
software 7, 28, 30, 140
See also applications
Sort by Date command 71
Sort by Name command 71
sorting
multimedia messages 78
text messages 71
To Do List items 90
sound clips 74, 75
sound files 74
Sound Mode Off option 41
sounds 41, 120, 128
See also alarms; music; ringtones
Sounds icon 117
speaker 10
speakerphone 11, 44, 154
special characters 24, 25
specifications 54, 111, 175
speed dial button 52
Spkr-phone button 44
stand by 37
starting
applications 26, 112
Blazer Web Browser 55
built-in tutorial 34
statistical functions (calculator) 96
status icons (text messages) 70
stereo adapters 54
storing
data 32, 111
Treo handset 10
stylus 8, 14, 20, 22
support 34
symbols 24, 25, 68
synchronization software 7, 28, 30
synchronizing data 28, 31, 147–149
system resets 141
system sounds 41, 120, 128

text
See also messages; notes
copying 60
finding on web pages 61, 99
in reverse type 19, 20
multimedia messages and 74, 75
selecting 20
text fields 19, 20
text messages
addressing 68, 72
creating 68
deleting 71, 72
dialing from 40, 70
receiving 69
replying to multimedia messages with 77
sending 68, 70, 71
setting preferences for 72
sorting 71
troubleshooting 146
viewing status of 70
text selection tools 19, 20
third-party applications 106, 108, 124, 152, 153
third-party software 18, 31
three-way calling 46
time 93, 94, 126
time formats 127
time slots (events) 82, 86
time zones 126
timestamps 72
tips 34
To Do List
  checking off items 90
  creating 88
  displaying items in 87, 88, 90
  prioritizing items in 89, 91
  removing items 88, 90
  setting preferences for 87, 90
  touchscreen. See screen
  transferring data 37, 101
  Treo handset
  additional references for 55
  aligning screen for 122
  caution for storing 10
  charging 11, 32, 37
  components shipped 7
  connecting to PCs 29
  customizing 115
  extending storage capacity 111
  features 8
  freeing space on 109, 153
  locking 129, 131, 132
  resetting 131, 141–142, 147
  setting up 14
  storing data on 32
  transferring information to 28, 37
  troubleshooting 152, 154
  turning on and off 13
  tutorial for 34
  viewing power status for 12
  trigonometric functions 96
troubleshooting 140, 152, 154
TTY icon 37
  turning down volume 15
  turning handset on and off 13
  turning on keyboard backlight 13, 23, 121
  turning on Wireless Mode 13
  turning screen on and off 13, 33
  Tutorial 34
  Typing Starts Contacts Search preference 38
U
  unauthorized users 129
  unlocking keyguard 14
  unlocking the handset 131
  unread messages 70
  untimed events 83, 84
  updating information 31
  upgrades 28, 109, 138, 148
  urgent messages 70
  URLs 70
  USB hubs 29
  USB ports 29
  user discussion groups 34
V
  viewing
    application information 110
    bookmarks 58
  calendar 82, 85, 86
  events 86
  expansion card information 114
  images 55, 61
  multimedia messages 75, 76, 77
  pictures 64, 67
  private records 135
  recently dialed numbers 40
  text messages 69
  To Do List items 87, 88, 90
  web pages 55, 58
  voice dialing 47
  Voice Gear 47
  voice messages 42, 75
  Voice Privacy option 48
  voicemail
    checking messages for 37, 70
    retrieving messages 37, 43
    sending messages to 41
    setting up 42
    Voicemail Favorites button 42
    voicemail icon 43
    voicemail services 41, 42
    volume buttons 9, 15, 116, 117
    volume conversions 96
    VP icon 48
W
  wallpaper 118, 119
Index

warranty 111
web browsing
  customizing 61
  overview 55
  requirements for 3, 6
  troubleshooting 145, 150
web links 19, 53, 56, 70
web pages
  adding bookmarks for 56
  clearing cache for 153
  copying from 60
  dialing from 40
  disabling images on 61
  displaying 55, 58
  downloading applications from 106
  navigating through 56, 60
  opening from text messages 70
  refreshing 55
  removing bookmarks for 58
  reverse type in 19
  saving 57
  searching 61
  setting Favorites buttons for 53
  viewing history lists for 60
  viewing offline 57
weekly events 84
weight conversions 96
Wide Page Mode command 56

Windows information
  installing applications 106, 107
  installing synchronization software 28
  removing applications 109
  synchronizing data 147, 148, 149
  viewing pictures 67
  wireless connections 13
  wireless coverage areas 14, 33, 144
  wireless features 13, 32
  Wireless Mode 13, 37, 145
  Wireless Mode button 8
  world clock 93–94

Z
zip files 106
**Specifications**

<table>
<thead>
<tr>
<th>Feature</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Radio</strong></td>
<td>CDMA 1900/800 digital dual-band 1XRTT; also supports CSD</td>
</tr>
<tr>
<td><strong>Phone features</strong></td>
<td>Personal speakerphone, Hands-free headset jack (2.5 mm, 3-pin barrel connector), Microphone mute option, TTY compatible, 3-way calling</td>
</tr>
<tr>
<td><strong>Processor Technology</strong></td>
<td>144 MHz Texas Instruments OMAP (ARM) processor</td>
</tr>
<tr>
<td><strong>Expansion</strong></td>
<td>SD &quot;+MMC(^\ast)&quot; slot (SD I/O compatible)</td>
</tr>
<tr>
<td><strong>Battery</strong></td>
<td>Rechargeable Lithium Ion, 3 hours full charge time, 4 hours talk time, 10 days standby</td>
</tr>
<tr>
<td><strong>Palm OS (^\ast) version</strong></td>
<td>Palm OS 5.2.x</td>
</tr>
<tr>
<td><strong>Camera(^\ast)</strong></td>
<td>VGA resolution (640x480), 0.3 megapixel, Automatic light balance</td>
</tr>
<tr>
<td><strong>Size</strong></td>
<td>4.41 in x 2.36 in x .87 in (11.2 cm x 6.0 cm x 2.2 cm) without antenna</td>
</tr>
<tr>
<td><strong>Weight</strong></td>
<td>6.2 ounces (175 grams)</td>
</tr>
<tr>
<td><strong>Display</strong></td>
<td>LCD CSTN Touchscreen (includes stylus), 3375 colors, 11.5-bit color, compatible with 16-bit applications, User-adjustable brightness and contrast</td>
</tr>
<tr>
<td><strong>Keyboard</strong></td>
<td>Built-in QWERTY keyboard plus 5-way navigation control, Backlight for low lighting conditions</td>
</tr>
<tr>
<td><strong>Included software</strong></td>
<td>Phone (including Palm OS Contacts, Favorites, Dial Pad), Pictures, MMS (multimedia messaging), Blazer® Web Browser (Internet), Memo Pad, PocketMirror Standard (for synchronizing with Microsoft Outlook for Windows), Calendar (Palm OS Date Book+), SMS (text messaging), To Do List, Palm® Desktop and HotSync® Manager, CityTime world clock</td>
</tr>
<tr>
<td><strong>System requirements</strong></td>
<td>Windows 98SE, Me, 2000, or XP with USB port, Windows NT4 requires serial cable, sold separately, Mac OS 10.1-10.3.x with USB port, Later versions may also be supported</td>
</tr>
<tr>
<td><strong>Operating and storage temperature range</strong></td>
<td>0°C-40°C, 5% to 90% RH</td>
</tr>
</tbody>
</table>

\(^\ast\) There are two models of Treo 600 available through Verizon: one comes with a camera and the other does not come with a camera. The packaging for your Treo 600 identifies whether a camera is included.